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1 Introduction

This Manual contains information about the CMT Network Analyzer remote
control and its data communication, carried out by means of user program
through a computer network.

This manual describes the analyzer command system and the network protocols

used to deliver commands. The commands sent to the analyzer and the
responses from it are text messages conforming to the SCPI (Standard
Commands for Programmable Instruments) specification. The text messages are
delivered over computer networks using TCP/IP Socket network protocols.

TCP/IP Socket is a general-purpose network protocol. The user program can
connect to the analyzer using the TCP/IP Socket protocol both directly and
through the VISA library.

VISA (Virtual Instrument Software Architecture) is a widely used software
inputoutput interface in the field of testing and measurement for controlling
devices from a personal computer. It is a library of functions for C / C ++, C #,
Visual Basic, MATLAB, LabVIEW and others. The VISA library unifies access to all
measuring instruments, regardless of the protocol and equipment used. The
VISA library is installed on the client side, that is, on the computer where the
user program is executed. The VISA library is available on the websites of many
companies for free.

1.1 Programming Manual Scope

This Manual directly applies to the Planar - TR1300/1, TR5048 and TR7530
models Network Analyzer.

1.2 Related Documents

Before reading this Manual, familiarize yourself with Analyzer Operating
Manual.

1.3 References

I[EEE Standard 488.2-1992, IEEE Standard Codes, Formats, Protocols and
Common Commands for Use with ANSI/IEEE Std 488.1-1987. IEEE, New York,
NY, 1992.

SCPI' Standard-1999, Standard Commands for Programmable Instruments
Volume 1: Syntax and Style. SCPI Consortium, San Diego, CA, 1999.

VISA specifications, http.,//www.ivifoundation.org/specifications.
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2 Analyzer Interfaces

2.1 Ethernet Interface
Ethernet interface is part of the equipment of a personal computer that
connects to the device "Planar - TR1300/1», «TR5048» or «TR7530x».

Data transfer between the PC user and the computer that is connected to the
device, is performed via Socket protocol (TCP, port 5025).

Connect the device to a PC in the local Ethernet network of your company.

Activate the function of remote control via Socket protocol on your Analyzer as
described below.

To enable/disable remote control via network Socket protocol, use the following
softkeys: System > Misc Setup > Network Setup > TCP Socket ON/OFF.

System Misc Setup ‘ Network Setup

TCP Socket
OFF

Port
5025
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3 SCPI Overview

The Ethernet interface implement same set of commands based on 1999 SCPI
standard (Standard Commands for Programmable Instruments). This command
set allows the exchange of character messages.

SCPI is developed by SCPI Consortium (http:\\www.scpiconsortium.org).The
main features of SCPl| standard are described below. For a more detailed
information on SCPI standard, see the website of SCPI Consortium.

3.1 Command Tree

The SCPI commands are organized in a tree structure. For example:

‘,‘,‘#_HEASUIE SYSTem
VOLTage RESistance® CURRent Local REMote
DC? AC? DC? AC?

Each tree structure forms a functional system. The base of the tree is called root,
e.g. MEASure and SYSTem. Each functional system can have subsystems of
lower level. The final nodes are called leaves. The entire sequence from root to
the leaf makes up the command. For example, part of SOURCe functional system
looks as follows:

:SOURce
:POWer

:CENTer

:STARt

: SPAN

:STOP

[:LEVel]

:SLOPe

[ :DATA]
:STATe
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SCPI Overview

This SOURce branch has several levels, where CENTer, STARt, SPAN,
STOP, DATA, STATe are the leaves, which represent the following six
commands:

:SOURce: POWer :CENTer

:SOURce: POWer: STARt
:SOURce: POWer : SPAN

:SOURce: POWer:STOP

:SOURce: POWer[:LEVel] : SLOPe [ : DATA]
:SOURce:POWer [:LEVel] : SLOPe:STATe

The tree can contain subsystems and leaves with the same names if they belong
to different branches, e.g. CENTer leaf is on the tips of different branches:

: SOURce :SENSe
:POWer :FREQuency
:CENTer :CENTer

3.2 Subsystems

A colon (")) separates the subsystems. The subsystems, which follow the colon
are of a lower level. For example, in command:

:SOURce :POWer: STARL

the start power STARt is a part of POWer subsystem, which is a part of SOURce
subsystem. The stop power is also a part of : SOURce: POWer subsystem. It is
specified by:

: SOURce: POWer:STOP
The first colon in the line can be omitted, for example:
SOURce: POWer:STOP

3.3 Optional Subsystems

Some subsystems can be specified as optional, if omission of such a subsystem
will not lead to ambiguity. This means that the subsystem can be omitted in
command line. The optional subsystems are bracketed ("[]"). For example, if full
command specification is written as:

SOURce:POWer [:LEVel] : SLOPe [ : DATA]

subsystems LEVel and DATA are optional. Therefore the both commands are
valid:

SOURce:POWer:LEVel :SLOPe:DATA
SOURce: POWer:SLOPe
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SCPI Overview

3.4 Long and Short Formats

Each keyword in a command specification has a long format and a short format.
The short format of a command is indicated by capital letters. For example, a
command specification:

SENSe:FREQuency:CENTer
can be written as:

SENS:FREQ:CENT

SENS:FREQ:CENTer

Only long or short form of each keyword is acceptable. For example, the
following specification is incorrect:

:SENS : FREQuen : CEN

3.5 Case Sensitivity

The commands are not case sensitive. Upper case and lower case letters are
only used to indicate the long and short formats of a command specification.
For example, the following commands are equivalent:

SENS:FREQ:STAR

sens:freqg:star

3.6 Parameters

The commands can have parameters. The parameters are separated from the
command by a space. If a command has several parameters, they are separated
by commas (',).

3.6.1 Numeric Values

The numeric values are integer or real numbers. These parameters can have
measurement units. For example:

SENS:FREQ 1000000000
SENS:FREQ 1000 MHz
SENS:FREQ 1 GHz
SENS:FREQ 1E9
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SCPI Overview

3.6.1.1 Multiplier Prefixes

The SCPI standard allows specification of the numeric values with multiplier

prefix to the measurement units.

Prefix Multiplier
A le-18
F le-15
P le-12
N le-9
U 18-6
M le-3
K le3
MA leo

G led

T lel2
PE lelb
EX lel8

There are two exceptions to the above designation: prefix M in combination
with HZ or OHM means 1le6 (Mega), and not le-3 (milli), i.e. MHZ means

Megahertz, same as MAHZ.

3.6.1.2 Notations

The SCPI standard allows numeric value specification in different notations.
Decimal notation is used by default. To use other notations, specify the numeric

values in the following way:

Notation Prefix Example

Binary #B #B11001010 = 202,
Octal #Q #Q107 = 71,
Hexadecimal #H #H10FF = 4351,
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SCPI Overview

3.6.2 Booleans

The booleans can assume two values: logical yes and logical no (ON and OFF),
and specified in command as:

ON or 1 - logical yes
OFF or 0 - logical no

For example:
DISPlay:ENABle OFF
DISPlay:ENABle 0

3.6.3 Character Data

The SCPI standard allows specification of parameters as character data, as in the
following command:

TRIGger:SOURce {BUS|IMMediate|EXTernal}
the possible values of the character data - "BUS", "IMMediate”, "EXTernal".

The character data have long and short format, and the formats are specified in
accordance with the same rules as described in Section 3.4.

Apart from that, the character data can be combined with numerical parameters.
For example:

SENSe:FREQuency:STARt {MINimum|MAXimum|<value>}
The following specifications are acceptable:
SENSe:FREQuency:STARt MIN
SENSe:FREQuency:STARt maximum
SENSe:FREQuency:STARt 1000000

3.6.4 String Parameters

In some cases, the instrument can accept parameters made of character strings.
Such strings are enclosed with single quotes (') or double quotes ("). For
example, the file name in the state saving command:

MMEMory:STORe "stateOl.sta"

3.6.5 Numeric Lists

The numeric lists (<numeric list>) are used to specify a variable number of
numerical parameters, for example:

CALC:LIMit:DATA 2,1,1E9,3E9,0,0,2,1E9,3E9,-3,-3
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3.7 Query Commands

The query commands read out the parameter values from the instrument. After a
query command has been sent, the response should return via remote control
interface.

The query commands has a question mark ('?') in the end of the command. Many
of the commands have two forms. The form with a question mark writes the
parameter, the form without a question mark reads out the parameter. For
expample:

SENSe:FREQuency:STARt 1 MHz
SENSe:FREQuency:STARt?

3.8 Numeric Suffixes

The instrument contains several items of the same type, such as 9 channels,
each of which in turn contains 8 traces, etc. A numeric suffix is used to denote
the item number in a command. The suffix is added to the keyword of the item
(channel, trace, etc). For expample, in the following specification the channel
number <Ch> and trace number <Tr> indicate the channel and trace, to which
this command is addressed:

CALCulate<Ch>:PARameter<Tr>:DEFine

According to this specification, the command referred to the trace 2 of the
channel 1 will be written as follows:

CALC1:PARZ:DEF

The numeric suffix can be omitted. In this case, it is 1 by default. For example,
the following commands are equivalent:

CALC:PAR:DEF
CALC1:PAR]1:DEF

3.9 Compound Commands

It is possible to enter more than one command in the same command line. The
commands in the line are separated by a semicolon (';'). The specification of the
first command is valid for the following command, except for the last leaf
before the semicolon. For expample:

SENS:FREQ:STAR 1 MHZ;STOP 2MHZ

If you need to start the next command from the highest level of the structure,
this command should start from a colon ('):

SENS:FREQ:STAR 1 MHZ; :CALC:PAR:DEF S21

18
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3.10 IEEE488.2 Common Commands Overview

A SCPI compatible instrument must support a set of common commands of
IEEE488.2 standard. These commands start with an asterix ('). The list of such
commands see below:

*CLS

*ESE

*ESE?

*ESR?

*IDN?

*OPC

*QOPC?

*RST

*SRE

*SRE?

*STB?

*TRG

*WAT

These commands are used for resetting, state queries, etc.

3.11 String Terminator

The <new line> character (ASCII 10) in the last data byte of the command string
is used as a command terminator. The string of instructions sent to the
instrument is executed after the instruction terminator is received.
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4 Remote Control Commands

4.1 Conventions

The following conventions are used throughout the Manual.

4.1.1 Syntax

The following symbols are used in command syntax:

<> identifiers enclosed in angular brackets indicated that a
particular type of data must be specified

[] part enclosed in square brackets can be omitted

{1} part enclosed in curly brackets indicates that you must select
one of the items in this part. Individual items are separated by a
vertical bar "

Space space separates commands from parameters
, comma separates adjacent parameters

ellipses indicates that parameters in that part are omitted

20



4.1.2 ldentifiers

Remote Control Commands

Identifier Parameter Description
<numeric> Number {<integer>|<real>}
<frequency> Frequency | <numeric>{[HZ] |KHZ|MHZ |GHZ}

<numeric>{ [DBM] | DBMW | DBW | KW | W | MW | UW |
<power> Power

NW }
<time> Time <numeric>{[S] |IMS|US|NS|PS|FS}

Log .
<logmag> . <numeric>[DB]
Amplitude

<phase> Phase <numeric>{ [DEG] | MADEG | KDEG | MDEG | UDEG}
<stimulus> Stimulus {<frequency>|<power>|<time>}
<response> Response {<logmag>|<phase>|<time>}
< .
lig?irlc Numeric List | <numeric 1>, <numeric 2>, ...<numeric N>
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Remote Control Commands

4.7 IEEE488.2 Common Commands

*CLS
*CLS
Clears the following (no query)
e Error Queue
« Status Byte Register
. » Standard Event Status Register
Description . .
 Operation Status Event Register
 Questionable Status Event Register
» Questionable Limit Status Event Register
 Questionable Limit Channel Status Event Register
Target Status Reporting System
Equivalent
Softkeys None
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“ESE

*ESE <numeric>

*ESE?

I Sets or reads out the value of the Standard Event Status Enable

Description )
Register (command/query).

Target Status Reporting System
Parameter <numeric> 0 to 255
Out of Range Bitwise AND with 255 number
Query Response | <numeric>
Preset Value 0
Equivalent
Softkeys None

“ESR?

*ESR?

. Reads out the value of the Standard Event Status Register.

Description . . .
Executing this command clears the register value (query only).

Target Status Reporting System
Query Response | <numeric>
Equivalent
Softkeys None
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“IDN?
*TDN?
Reads out the instrument information string. The string format:
<manufacturer>, <model>, <serial number>, <software
Description version/firmware version> (query only).
For example: Copper Mountain Technologies, Planar - TR1300/1,
00000101, 0.8.12/1.0
Target Instrument
Query Response | String up to 40 characters
Equivalent
Softkeys None
*OPC
*OPC
_ Sets the OPC bit (bit 0) of the Standard Event Status Register at the
Description . . .
completion of all pending operations (no query).
Target Status Reporting System
Equivalent
Softkeys None
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*OPC?
*OPC?
Description 1 is read out at the completion of all pending operations (query
only).
Target Status Reporting System
Query Response | 1
Equivalent
Softkeys None
*RST
*RST
Restores the default settings of the instrument (no query).
Description There is difference from presetting the instrument with
:SYST: PRES command - in this case the trigger mode is set to
Hold.
Target Instrument
Related SYSTem: PRESet
Commands
Equivalent
Softkeys None
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*SRE

Remote Control Commands

*SRE <numeric>

*SRE?

Description Sets or reads out the value of the Service Request Enable Register

(command/query)

Target Status Reporting System

Parameter <numeric> 0 to 255.

Out of Range Bitwise AND with 255 number

Query Response | <numeric>

Preset Value 0

oot von

*STB?

HSMB7

Description Reads out the value of the Status Byte Register (query only).
Target Status Reporting System

Query Response | <numeric>

e
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“TRG
*TRG
If the trigger source is set to LAN (set to BUS with the : TRIG: SOUR
command), triggers a sweep.
. If the trigger source is not set to the bus or the instrument is not
Description . . .
waiting for a trigger, the command is ignored.
The command is completed before the end of the sweep.
(no query)
Target Instrument
Related TRIG:SOUR
Commands
Equivalent
q None
Softkeys
*WAI
*WAT
. Waits for the execution of all commands sent before this command.
Description
(no query)
Target Instrument
Equivalent
q None
Softkeys
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4.3 Network Analyzer Commands

ABOR
ABORt
Aborts the sweep and switches the triggers of all the channels to
Hold. The channels in Continuous trigger mode switch to waiting for
Description a trigger. If the trigger source is set to Internal, the channel from
waiting for a trigger turns to a new sweep.
(no query)
Equivalent
Softkeys None
CALC:CONV

CALCulate<Ch>[:SELected] :CONVersion[:STATe] {ON|OFF|1]|0}

CALCulate<Ch>[:SELected] :CONVersion|[:STATe] ?

Sets or reads out the ON/OFF state of S—parameter conversion

Description function (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]1213141516171819}
{ON|1}  S-parameter conversion function ON
Parameter
{OFF |10} S-parameter conversion function OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Conversion > Conversion
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Remote Control Commands

CALC:CONV:FUNC

CALCulate<Ch>[:SELected] :CONVersion:FUNCtion <char>

CALCulate<Ch>[:SELected] :CONVersion:FUNCtion?

Sets or reads out the S—parameter conversion function type

Description (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1]12131415161718]9}
<char> specifies parameter:
IMPedance : Equivalent transmission or reflection
impedance, depending on the parameter S11 or
S21
Parameter ADMittance : Equivalent transmission or reflection
conductance, depending on the parameter S11 or
S21
INVersion : Inverse S—parameter
CONlJugation : S-parameter conjugate
Out of Range Error occurs. The command is ignored.
Query Response | {IMP|ADM|INV|CONJ}

Preset Value

IMP

Equivalent
Softkeys

Analysis > Conversion > Function { Impedance Z | Admittance Y |
Inverse 1/S | Conjugation }
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Remote Control Commands

CALC:CORR:EDEL:TIME

CALCulate<Ch>[:SELected] :CORRection:EDELay:TIME <time>

CALCulate<Ch>[:SELected] :CORRection:EDELay:TIME?

Description Sets or reads out the value of the electrical delay (command/query).

Target The active trace of channel <Ch>,
<Ch>={[111213141516171819}

Parameter <time> the electrical delay value from -10 to 10

Unit s (second)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value 0

Equivalent
Softkeys

Scale > Electrical Delay
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Remote Control Commands

CALC:CORR:OFFS:PHAS

CALCulate<Ch>[:SELected] :CORRection:0FFSet:PHASe <phase>

CALCulate<Ch>[:SELected] :CORRection:0OFFSet :PHASe?

Description Sets or reads out the value of the phase offset (command/query).

Target The active trace of channel <Ch>,
<Ch>={[111213141516171819}

Parameter <phase> the phase offset value from -360 to 360

Unit ° (degree)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value 0

Equivalent
Softkeys

Scale > Phase Offset
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CALC:DATA:FDAT?

CALCulate<Ch>[:SELected] : DATA:FDATa?

Reads out the formatted data array (query only).

The formatted data array is the data, whose processing is completed
including the formatting as the last step. Such data represent the
data trace values as they are shown on the screen.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

Description
<numeric 2n-1>  real number in rectangular format, real part
in polar and Smith chart formats;
<numeric 2n> 0 in rectangular format, imaginary part in
polar and Smith chart formats.
Taraet The active trace of channel <Ch>,
g <Ch>={[1112131415/61718]9}
<numeric 1>, <numeric 2>, ..<numeric 2N>
Query Response The data transfer format depends on the FORM: DATA command
setting.
Related CALC:FORM
Commands FORM:DATA
Equivalent
q None
Softkeys
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CALC:DATA:FMEM?

CALCulate<Ch>[:SELected] : DATA: FMEMory?

Reads out the formatted memory array (query only).

The formatted memory array is the data, whose processing is
completed including the formatting as the last step. Such data
represent the memory trace values as they are shown on the screen.
The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

Description
<numeric 2n-1>  real number in rectangular format, real part
in polar and Smith chart formats;
<numeric 2n> 0 in rectangular format, imaginary part in
polar and Smith chart formats.
Taraet The active trace of channel <Ch>,
g <Ch>={[1]12131415161718]9}
<numeric 1>, <numeric 2>, ..<numeric 2N>
Query Response The data transfer format depends on the FORM: DATA command
setting.
Notes If the memory is empty, an error occurs and the command is
ignored.
CALC:MATH:MEM
Related CALC:FORM
Commands FORM: DATA
Equivalent
q None
Softkeys
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CALC:DATA:SDAT?

CALCulate<Ch>[:SELected] : DATA:SDATa?

Reads out the corrected data array (query only).

The corrected data array is the data, whose processing is completed
excluding the formatting as the last step. Such data represent S-
parameter complex values.

The array size is 2N, where N is the number of measurement points.

Description i
For the n-th point, where n from 1 to N:
<numeric 2n-1> the real part of corrected measurement;
<numeric 2n> the imaginary part of corrected measurement.

Taraet The active trace of channel <Ch>,

g <Ch>={[1112131415/61718]9}

<numeric 1>, <numeric 2>, .<numeric 2N>

Query Response The data transfer format depends on the FORM: DATA command
setting.

Related FORM:DATA

Commands

Equivalent

q None
Softkeys
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CALC:DATA:SMEM?

CALCulate<Ch>[:SELected] : DATA: SMEMory?

Reads out the corrected memory array (query only).

The corrected memory array is the data, whose processing is
completed excluding the formatting as the last step. Such data
represent S—parameter complex values.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

Description
<numeric 2n-1> the real part of corrected measurement
memory;
<numeric 2n> the imaginary part of corrected measurement
memory.
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/6/718]9}
<numeric 1>, <numeric 2>, ..<numeric 2N>
Query Response The data transfer format depends on the FORM: DATA command
setting.
Notes If the memory is empty, an error occurs and the command is
ignored.
Related CALC:MATH :MEM
Commands FORM:DATA
Equivalent
q None
Softkeys
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CALC:FILT:TIME

CALCulate<Ch>[:SELected] :FILTer [:GATE] :TIME[:TYPE] <char>

CALCulate<Ch>[:SELected] :FILTer [:GATE] :TIME[:TYPE] ?

Sets or reads out the gate type of the gating function

Description (command/query).

Target The active trace of channel <Ch>,
<Ch>={[1]112131415]161718]9}
<char> specifies the gate type:

Parameter BPASs : Bandpass type
NOTCh  :Notch type

Out of Range Error occurs. The command is ignored.

Query Response | {BPAS|NOTC}

Preset Value

BPAS

Equivalent
Softkeys

Analysis > Gating > Type
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CALC:FILT:TIME:CENT

CALCulate<Ch>[:SELected] :FILTer[:GATE] : TIME:CENTer <time>

CALCulate<Ch>[:SELected] :FILTer [:GATE] : TIME : CENTer?

Sets or reads out the gate center value of the gating function

Description (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<time> the center value of the gate, the range varies depending on
Parameter .
the frequency span and the number of points
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Analysis > Gating > Center
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Remote Control Commands

CALC:FILT:TIME:SHAP

CALCulate<Ch>[:SELected] :FILTer [:GATE] : TIME: SHAPe <char>

CALCulate<Ch>[:SELected] :FILTer [ :GATE] : TIME : SHAPe?

Sets or reads out the gate shape of the gating function

Description (command/query).

Target The active trace of channel <Ch>,
<Ch>={[1]112131415161718]9}
<char> specifies the gate shape:
MAXimum : Maximum shape

Parameter WIDE : Wide shape
NORMal : Normal shape
MINimum : Minimum shape

Out of Range Error occurs. The command is ignored.

Query Response | {MAX|WIDE |NORM|MIN}

Preset Value

NORM

Equivalent
Softkeys

Analysis > Gating > Shape > { Maximum | Wide | Normal | Minimum }
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CALC:FILT:TIME:SPAN

CALCulate<Ch>[:SELected] :FILTer[:GATE] : TIME: SPAN <time>

CALCulate<Ch>[:SELected] :FILTer [:GATE] : TIME : SPAN?

Sets or reads out the gate span value of the gating function

Description (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/6]718]9}
<time> the span value of the gate, the range varies depending on
Parameter .
the frequency span and the number of points
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 2e-8

Equivalent
Softkeys

Analysis > Gating > Span
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CALC:FILT:TIME:STAR

CALCulate<Ch>[:SELected] :FILTer[:GATE] : TIME: STARt <time>

CALCulate<Ch>[:SELected] :FILTer [ :GATE] : TIME: STARt?

Sets or reads out the gate start value of the gating function

Description (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1]121314151617181]9}
<time> the start value of the gate, the range varies depending on
Parameter .
the frequency span and the number of points
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value -le-8

Equivalent
Softkeys

Analysis > Gating > Start
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CALC:FILT:TIME:STAT

CALCulate<Ch>[:SELected] :FILTer [:GATE] : TIME: STATe {ON|OFF |10}

CALCulate<Ch>[:SELected] :FILTer [:GATE] : TIME: STATe?

Sets or reads out the ON/OFF state of the gating function

Description (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1112131415|6]1718]9}
{ON|1} Gating function ON
Parameter
{OFF|0} Gating function OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Gating > Gating
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CALC:FILT:TIME:STOP

CALCulate<Ch>[:SELected] :FILTer[:GATE] : TIME:STOP <time>

CALCulate<Ch>[:SELected] :FILTer [:GATE] : TIME: STOP?

Sets or reads out the gate stop value of the gating function

Description (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<time> the stop value of the gate, the range varies depending on
Parameter .
the frequency span and the number of points
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value +1le-8

Equivalent
Softkeys

Analysis > Gating > Stop
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CALC:FORM

CALCulate<Ch>[:SELected]

CALCulate<Ch>[:SELected]

Remote Control Commands

:FORMat {<char>

:FORMat?

Description Sets or reads out the trace format (command/query).
Target The active trace of channel <Ch>,
<Ch>={[111213141516171819}
<char> specifies the trace format:
MLOGarithmic : Logarithmic magnitude
PHASe : Phase
GDELay : Group delay time
SLINear : Smith chart format (Lin)
SLOGarithmic : Smith chart format (Log)
SCOMplex : Smith chart format (Real/Imag)
SMITh : Smith chart format (R + jX)
Parameter SADMittance : Smith chart format (G + jB)
PLINear : Polar format (Lin)
PLOGarithmic : Polar format (Log)
POLar : Polar format (Real/Imag)
MLINear : Linear magnitude
SWR : Voltage standing wave ratio
REAL : Real part
IMAGinary : Imaginary part
UPHase : Expanded phase
Out of Range Error occurs. The command is ignored.
Ouery Response {MLOG | PHAS | GDEL | SLIN | SLOG | SCOM| SMIT | SADM| PLIN |

PLOG|POL |MLIN|SWR|REAL|IMAG|UPH}

Preset Value

MLOG

Equivalent
Softkeys

Response > Format > { Log Mag | Phase | Group Delay | Lin Mag |
SWR | Real | Imag | Phase Exp }

Response > Format > Smith > { Log/Phase | Lin/Phase | Real/Imag |

R+jX | G+jB }

Response > Format > Polar > { Log/Phase | Ling/Phase | Real/Imag }
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CALC:FSIM:SEND:DEEM:PORT:STAT

CALCulate<Ch>:FSIMulator:SENDed:DEEMbed: PORT<Pt>:STATe

{ON|OFF |10}

CALCulate<Ch>:FSIMulator:SENDed:DEEMbed: PORT<Pt>:STATe?

Sets or reads out the ON/OFF state of the de—embedding function

Description (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]12131415]16]1718]9}
<Pt>={[111]2}
{ON|1}  De-embedding function ON
Parameter
{OFF |10} De-embedding function OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Fixture Simulator > De-Embedding > Port n
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CALC:FSIM:SEND:DEEM:PORT:USER:FIL

CALCulate<Ch>:FSIMulator:SENDed:DEEMbed: PORT<Pt>:USER:FILename

<string>

CALCulate<Ch>:FSIMulator:SENDed:DEEMbed: PORT<Pt>:USER:FILename

?

Sets or reads out the name of *.s2p file of the de—embedded circuit

Description of the de-embedding function (command/query). The file contains
the circuit S-parameters in Touchstone format.
Port <Pt> of channel <Ch>,

Target <Ch>={[1]121314|15]|6]1718]9}
<Pt>={[1]1]2}

Parameter <srting>, up to 256 characters (quoted string)

Preset Value

If the full path of the file is not specified, the \FixtireSim

Notes subdirectory of the main directory will be searched for the file.
Equivalent . . . . .
Softkeys Analysis > Fixture Simulator > De-Embedding > S-parameters File
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CALC:FSIM:SEND:PMC:PORT:STAT

CALCulate<Ch>:FSIMulator:SENDed:DEEMbed: PORT<Pt>:STATe

{ON|OFF |10}

CALCulate<Ch>:FSIMulator:SENDed:PMCircuit:PORT<Pt>:STATe?

Sets or reads out the ON/OFF state of the embedding function

Description (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]12131415]16]1718]9}
<Pt>={[111]2}
{ON|1} Embedding function ON
Parameter
{OFF |10}  Embedding function OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Fixture Simulator > Embedding > Port n
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CALC:FSIM:SEND:PMC:PORT:USER:FIL

CALCulate<Ch>:FSIMulator:SENDed:PMCircuit :PORT<Pt>:USER:
FILename <string>

CALCulate<Ch>:FSIMulator:SENDed:PMCircuit :PORT<Pt>:USER:

FILename?
Sets or reads out the name of *.s2p file of the embedded circuit of
Description the embedding function (command/query). The file contains the
circuit S—parameters in Touchstone format.
Port <Pt> of channel <Ch>,
Target <Ch>={[1112131415]161718]9}
<Pt>={[1]|2}
Parameter <string>, up to 256 characters (quoted string)

Preset Value

If the full path of the file is not specified, the \FixtireSim

Notes subdirectory of the main directory will be searched for the file.
Equivalent . . . . .
Softkeys Analysis > Fixture Simulator > Embedding > User File
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CALC:FSIM:SEND:ZCON:PORT:Z0

CALCulate<Ch>:FSIMulator:SENDed:ZCONversion: PORT<Pt>:Z0[:R]

<impedance>

CALCulate<Ch>:FSIMulator:SENDed:ZCONversion:PORT<Pt>:Z0[:R]?

Sets or reads out the value of the impedance for port impedance

Description conversion function (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]112131415]61718]9}
<Pt>={[1]12}
Parameter <impedance> the impedance value from le-6to 1le6
Unit Q (Ohm)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 50

Equivalent
Softkeys

Analysis > Fixture Simulator > Port Z Conversion > Port n Z0

48




Remote Control Commands

CALC:FSIM:SEND:ZCON:STAT

CALCulate<Ch>:FSIMulator:SENDed:ZCONversion:STATe {ON|OFF|1]0}

CALCulate<Ch>:FSIMulator:SENDed:ZCONversion:STATe?

Sets or reads out the ON/OFF state of the port impedance

Description conversion function (command/query).
Taraet Channel <Ch>,
9 <Ch>={[11121314|5]6]17|8]9}
{ON]1} Port Z conversion function ON
Parameter
{OFF |0} Port Z conversion function OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Fixture Simulator > Port Z Conversion > Port Z Conversion
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CALC:FUNC:DATA?

CALCulate<Ch>[:SELected] : FUNCtion:DATA?

Reads out the data array, which is the CALC : FUNC: EXEC command

analysis result (query only).

The array size is 2N, where N is the number of points set by
CALC:FUNC:POIN? command.

For the n-th point, where n from 1 to N:

Description <numeric 2n-1>  the response value in n-th measurement
point;
<numeric Z2Zn> the stimulus value in n-th measurement
point. Always set to O for the analysis of
mean value, standard deviation, and peak-
to-peak value.
Taraet The active trace of channel <Ch>,
g <Ch>={[1]1213141516/718]9}
<numeric 1>, <numeric 2>, .<numeric 2N>
Query Response The data transfer format depends on the FORM: DATA command
setting.
CALC:FUNC:EXEC
Related CALC:FUNC:POIN?
Commands FORM: DATA
Equivalent
q None
Softkeys
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CALC:FUNC:DOM

CALCulate<Ch>[:SELected] : FUNCtion:DOMain[:STATe] {ON|OFF|1]|0}

CALCulate<Ch>[:SELected] :FUNCtion:DOMain[:STATe]?

Sets or reads out the ON/OFF state of an arbitrary range use in

Description CALC:FUNC:EXEC command (command/query).
All traces of channel <Ch> (if the coupling is set to ON by the
Target CALC:FUNC:DOM: COUP command), the active trace of channel
<Ch> (if otherwise),
<Ch>={[1]12131415161718]9}
{ON|1}  Arbitrary range ON
Parameter
{OFF|0} Arbitrary range OFF (entire sweep range)
Query Response | {01}
Preset Value 0

Related CALC:FUNC:EXEC
Commands CALC:FUNC:DOM:COUP
Equivalent

q None
Softkeys
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CALC:FUNC:DOM:COUP

CALCulate<Ch>[:SELected] : FUNCtion:DOMain:COUPle {ON|OFF|[1]0}

CALCulate<Ch>[:SELected] : FUNCtion:DOMain:COUPle?

Sets or reads out the ON/OFF state of trace coupling for analysis

Description range of the CALC : FUNC : EXEC command (command/query).
Taraet All traces of channel <Ch>,
g <Ch>={[1112131415]|6]1718]9}
{ON|1}  coupling ON
Parameter
{OFF 10} coupling OFF
Query Response | {01}
Preset Value 1

Related CALC: FUNC : EXEC
Commands

Equivalent

Softkeys None
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CALC:FUNC:DOM:STAR

CALCulate<Ch>[:SELected] :FUNCtion:DOMain:STARt <stimulus>

CALCulate<Ch>[:SELected] : FUNCtion:DOMain:STARt?

Sets the start value of the analysis range of the CALC : FUNC : EXEC

Description command (command/query).
All traces of channel <Ch> (if the coupling is set to ON by the
Target CALC:FUNC:DOM: COUP command), the active trace of channel
<Ch> (if otherwise),
<Ch>={[1]112131415]161718]9}
Parameter <stimulus> the start value of analysis range
Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }
Query Response | <numeric>
Preset Value 0

Related CALC : FUNC : DOM
Commands

Equivalent

Softkeys None
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CALC:FUNC:DOM:STOP

CALCulate<Ch>[:SELected] :FUNCtion:DOMain:STOP <stimulus>

CALCulate<Ch>[:SELected] : FUNCtion:DOMain:STOP?

Sets the stop value of the analysis range of the CALC: FUNC:EXEC

Description command (command/query).
All traces of channel <Ch> (if the coupling is set to ON by the
Target CALC:FUNC:DOM: COUP command), the active trace of channel
<Ch> (if otherwise),
<Ch>={[1]12131415161718]9}
Parameter <stimulus> the stop value of analysis range
Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }
Query Response | <numeric>
Preset Value 0

Related CALC : FUNC : DOM
Commands

Equivalent

Softkeys None
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CALC:FUNC:EXEC

CALCulate<Ch>[:SELected] : FUNCtion:EXECute

Executes the analysis specified by the CALC: FUNC: TYPE
command.

Description The analysis result can be read out by the CALC: FUNC: DATA?
command.
(no query)

Taraet The active trace of channel <Ch>,

7 <Ch>={[1112131415/6171819}

Related CALC:FUNC:TYPE

Commands CALC:FUNC:DATA?

Equivalent

7 None
Softkeys

55




Remote Control Commands

CALC:FUNC:PEXC

CALCulate<Ch>[:SELected] : FUNCtion:PEXCursion <response>

CALCulate<Ch>[:SELected] :FUNCtion:PEXCursion?

Sets the lower limit for the peak excursion value when executing

Description the peak search with the CALC: FUNC: EXEC command
(command/query).

Taraet The active trace of channel <Ch>,

9 <Ch>={[1]112131415/61718]9}

<response> the lower limit of the peak excursion value, varies

Parameter .
depending on the data format

Unit { dB (decibel) | ° (degree) | s (second) }

Query Response | <numeric>

Preset Value 3

Related CALC: FUNC : EXEC
Commands

Equivalent

Softkeys None
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CALC:FUNC:POIN?

CALCulate<Ch>[:SELected] :FUNCtion:POINts?

Reads out the number of points (data pairs) of the analysis result by
the CALC: FUNC: EXEC command (query only).
Always reads out 1, when the search is executed for the maximum,

Description .. ..

p minimum, mean, standard deviation, peak, and peak-to-peak
values. The actual number of points is read out, when the search is
executed for all peak or all targets.

Taraet The active trace of channel <Ch>,
g <Ch>={[1112131415/61718]9}

Query Response | <numeric>
Related CALC:FUNC:EXEC
Commands
Equivalent

q None
Softkeys
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CALC:FUNC:PPOL

CALCulate<Ch>[:SELected] :FUNCtion:PPOLarity <char>

CALCulate<Ch>[:SELected] : FUNCtion:PPOLarity?

Selects the polarity when performing the peak search with the

Description CALC:FUNC:EXEC command (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1]121314151617181]9}
<char> specifies the polarity:
POSitive : Positive peaks
Parameter
NEGative : Negative peaks
BOTH : Both positive peaks and negative peaks
Out of Range The command is ignored.
Query Response | {POS |NEG|BOTH}

Preset Value

POS

Related CALC: FUNC : EXEC
Commands

Equivalent

Softkeys None

58




Remote Control Commands

CALC:FUNC:TARG

CALCulate<Ch>[:SELected] : FUNCtion:TARGet <response>

CALCulate<Ch>[:SELected] : FUNCtion:TARGet?

Selects the target level when performing the search for the trace

Description and the target level crosspoints with the CALC: FUNC: EXEC
command (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
Parameter <response> the target value, varies depending on the data format
Unit { dB (decibel) | ° (degree) | s (second) }
Query Response | <numeric>
Preset Value 0

Related CALC : FUNC : EXEC
Commands

Equivalent

Softkeys None
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CALC:FUNCTTR

CALCulate<Ch>[:SELected] :FUNCtion:TTRansition <char>

CALCulate<Ch>[:SELected] :FUNCtion:TTRansition?

Selects the transition type when performing the search for the trace

Description and the target level crosspoints with the CALC: FUNC: EXEC
command (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<char> specifies the type of transition:
POSitive : Positive peaks
Parameter
NEGative : Negative peaks
BOTH : Both positive peaks and negative peaks
Out of Range The command is ignored.
Query Response | {POS|NEG|BOTH}
Preset Value POS
Related CALC:FUNC:EXEC
Commands
Equivalent
Softkeys None
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CALC:FUNC:TYPE

CALCulate<Ch>[:SELected] :FUNCtion:TYPE <char>

CALCulate<Ch>[:SELected] :FUNCtion:TYPE?

Selects the type of analysis executed with the CALC: FUNC:EXEC

Description command (command/query).
Target The active trace of channel <Ch>,
<Ch>={[1]112131415]161718]9}
<char> specifies the transition:
PTPeak : Peak-to-peak (difference between the maximum
value and the minimum value)
STDEV : Standard deviation
MEAN : Mean value
Parameter MAXimum : Maximum value
MINimum : Minimum value
PEAK : Search for peak
APEak : Search for all the peaks
ATARget : Search for all targets
Out of Range The command is ignored.
Query Response | {PTP|STDEV |MEAN |MAX |MIN | PEAK |APE |ATAR}
Preset Value PTP
?Zﬁfjgﬁds CALC:FUNC:EXEC
I o
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CALC:LIM

CALCulate<Ch>[:SELected] :LIMit[:STATe] {ON|OFF|1]|0}

CALCulate<Ch>[:SELected] :LIMit[:STATe]?

Sets or reads out the ON/OFF state of the limit test function

Description (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1]121314|5]6]1718]9}
{ON]1} Limit test function ON
Parameter
{OFF |0} Limit test function OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Limit Test > Limit Test
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CALC:LIM:DATA

CALCulate<Ch>[:SELected] :LIMit:DATA <numeric list>

CALCulate<Ch>[:SELected] : LIMit :DATA?

Sets the data array, which is the limit line in the limit test function
(command/query).

The array size is 1 + 5N, where N is the number of limit line
segments.

For the n-th point, where n from 1 to N:

<numeric 1> the number of limit line segments N is from
0 to 100. Setting O clears the Llimit line.

<numeric 5n -3> type of the n-th limit line segment
e 0:Off.
e 1:Upper limit

Description o 2:Lower limit
e 3:Single Point Limit
<numeric 5n-2>  the stimulus value in the start point of the
n-th segment
<numeric 5n-1> the stimulus value in the end point of the
n-th segment
<numeric 5n-0>  the response value in the start point of the
n-th segment
<numeric 5n+1> the response value in the end point of the
n-th segment
Taraet The active trace of channel <Ch>,
g <Ch>={[1]12131415161718]9}
<numeric 1>, <numeric 2>, .<numeric 5N+1>
Query Response The data transfer format depends on the FORM: DATA command
setting.
If the array size is not 1 + 5N, where N is <numeric 1>, an error
occurs. If <numeric 5n-3>is less than O or more than 2, an error
Notes occurs. When <numeric 5n-2>, <numeric 5n-1>,
<numeric 5n-0>,and <numeric 5n+1> elements are out of
allowable range, the value is set to the limit, which is closer to the
specified value.
Related FORM:DATA
Commands
Equivalent . . .
q Analysis > Limit Test > Edit Limit Line
Softkeys
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CALC:LIM:DISP

CALCulate<Ch>[:SELected] :LIMit:DISPlay|[:STATe]

{ON|OFF |10}

CALCulate<Ch>[:SELected] :LIMit:DISPlay|[:STATe]?

Sets or reads out the ON/OFF state of the limit line display of the

Description Llimit test function (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1]12131415161718]9}
{ON|1}  Limit line display ON
Parameter
{OFF |0} Limit line display OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Limit Test > Limit Line

CALC:LIM:FAIL?

CALCulate<Ch>[:SELected] :LIMit:FAIL?

Description Reads out the limit test result (query only).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
1 Fail
Query Response
0 Pass
Equivalent
Softkeys None
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CALC:LIM:OFFS:AMPL

CALCulate<Ch>[:SELected] :LIMit:0FFSet:AMPLitude <response>

CALCulate<Ch>[:SELected] :LIMit:0FFSet:AMPLitude?

Sets the value of the limit line offset along Y -axis

Description (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1112131415/6]718]9}
<response> the value of the limit line offset along Y -axis, varies
Parameter .
depending on the data format
Unit { dB (decibel) | ° (degree) | s (second) }
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Analysis > Limit Test > Limit Line Offsets > Response Offset
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CALC:LIM:OFFS:STIM

CALCulate<Ch>[:SELected] :LIMit:0OFFSet:STIMulus <stimulus>

CALCulate<Ch>[:SELected] :LIMit:0FFSet:STIMulus?

Sets the value of the limit line offset along X-axis

Description (command/query).

Target The active trace of channel <Ch>,
<Ch>={[1]112131415]61718]9}

Parameter <stimulus> the value of the limit line offset along X-axis

Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }

Query Response | <numeric>

Preset Value 0

Equivalent
Softkeys

Analysis > Limit Test > Limit Lines Offsets > Stimulus Offset

66




Remote Control Commands

CALC:LIM:REP:ALL?

CALCulate<Ch>[:SELected] :LIMit:REPort:ALL?

Reads out the data array, which is the Llimit test results (query only).
The array size is 4N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

<numeric 4n-3>  the stimulus value in the n-th point;

<numeric 4n-2>  the limit test result in the n-th point;
e —1:No limit

Description .
p e 0: Fail
e 1: Pass
<numeric 4n-1>  the upper limit value in the n-th point (0 - if
there is no limit)
<numeric 4n-0>  the lower limit value in the n-th point (0 - if
there is no limit)
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<numeric 1>, <numeric 2>, .<numeric 4N>
Query Response The data transfer format depends on the FORM: DATA command
setting.
Related FORM:DATA
Commands
Equivalent
q None
Softkeys
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CALC:LIM:REP:POIN?

CALCulate<Ch>[:SELected] :LIMit :REPort:POINts?

Reads out the number of the measurement points that failed the
Llimit test (query only).

Description . .
P The stimulus data array of these points can be read out by the
CALC:LIM:REP? command.
Taraet The active trace of channel <Ch>,
g <Ch>={[1112131415/6]718]9}
Query Response | <numeric>
Related CALC:LIM:REP?
Commands
Equivalent
q None
Softkeys
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CALC:LIM:REP?

CALCulate<Ch>[:SELected] :LIMit:REPort[:DATA]?

Reads out the data array, which is the stimulus values of the

Description measurement points that failed the limit test (query only).
The array size is set by the CALC: LIM:REP: POIN? command.

Taraet The active trace of channel <Ch>,

9 <Ch>={[1]112131415/6]718]9}

<numeric 1>, <numeric 2>,.<numeric N>

Query Response The data transfer format depends on the FORM: DATA command
setting.

Related CALC:LIM:REP:POIN?

Commands FORM:DATA

Equivalent

q None
Softkeys
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CALC:MARK

CALCulate<Ch>[:SELected] :MARKer<Mk>[:STATe] {ON|OFF |10}

CALCulate<Ch>[:SELected] :MARKer<Mk>[:STATe] ?

Sets or reads out the ON/OFF state of a marker (command/query).
Turning ON a marker with the number from 1 to 15 will turn ON all
the markers of smaller numbers. Turning OFF a marker with the
number from 1 to 15 will turn OFF all the markers of greater

Description numbers (except of the reference marker). Turning ON/OFF the
reference marker with number 16 does not turn ON/OFF the
markers with the numbers from 1 to 15, but switchs these markers
to the relative measurement mode.

Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1]121314|5]6]1718]9}
<Mk>={[1]121314|5]6]1718]19110111112113|14|15|16}
{ON]| 1} marker ON

Parameter
{OFF |0} marker OFF

Query Response | {01}

Preset Value 0

Equivalent
Softkeys

Markers > Add Marker | Remove Marker
Markers > Reference Marker
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CALC:MARK:ACT

CALCulate<Ch>:SELected] :MARKer<Mk>:ACTivate

Sets the active marker (no query).

If the marker is not ON, this function will turn the marker ON.
Turning ON a marker with the number from 1 to 15 will turn ON all

Description the markers of smaller numbers. Turning ON the reference marker
with number 16 does not turn ON the markers with the numbers
from 1 to 15, but switchs these markers to the relative measurement
mode.

Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1112131415]|6]1718]9}
<Mk>={[1]121314|5]6]1718]19110111112|13|114|15|16}

Equivalent Markers > Active Marker > Marker n

Softkeys Markers > Reference Marker

CALC:MARK:BWID

CALCulate<Ch>[:SELected] :MARKer:BWIDth[:STATe] {ON|OFF|1]|0}

CALCulate<Ch>[:SELected] :MARKer:BWIDth[:STATe]?

Sets or reads out the ON/OFF state of the bandwidth search

Description function (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]1121314|5]6]1718]9}
{ON|1} Bandwidth search function ON
Parameter
{OFF |0} Bandwidth search function OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Markers > Marker Math > Bandwidth Search > Bandwidth Search
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CALC:MARK:BWID:DATA?

CALCulate<Ch>[:SELected] :MARKer<Mk>:BWIDth:DATA?

Reads out the bandwidth search result (query only).

The bandwidth search can performed relatively to the marker <Mk>,
or relatively to the absolute maximum value of the trace (in this
case the number of the marker is ignored), what is set by the
CALC:MARK:BWID:REF command.

The data include 4 elements:

Description
<numeric 1> Bandwidth;
<numeric 2> Center frequency;
<numeric 3> Q value;
<numeric 4> Loss;
Marker <Mk> of the active trace of channel <Ch>,
Target <Ch>={[1]121314|5|6]1718]9}
<Mk>={[1]12131415|6171819110|11|12|13|14|15|16}
Query Response | <numeric 1>, <numeric 2>, .<numeric 4>
Related CALC:MARK:BWID:REF
Commands
If the bandwidth search is impossible, all the read out values are 0.
Notes If the search is performed relatively to a maker, which is OFF, an
error occurs.
Equivalent
q None
Softkeys
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CALC:MARK:BWID:REF

CALCulate<Ch>[:SELected] :MARKer:BWIDth:REFerence <char>

CALCulate<Ch>[:SELected] :MARKer:BWIDth:REFerence?

Selects the reference point for the bandwidth search function:

Description reference marker or absolute maximum value of the trace
(command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[11121314|5]6]17|8]9}
<char> choose from:
MARKer : Bandwidth search relative to the reference marker
Parameter MAXimum : Bandwidth search relative to the absolute maximum
of the trace
MINimum : Bandwidth search relative to the absolute minimum
of the trace
Out of Range The command is ignored.
Query Response | {MAX|MARK |MIN}

Preset Value

MAX

Equivalent
Softkeys

Markers > Marker Math > Bandwidth Search > Search Ref To
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CALC:MARK:BWID:THR

CALCulate<Ch>[:SELected] :MARKer<Mk>:BWIDth: THReshold

<response>

CALCulate<Ch>[:SELected] :MARKer<Mk>:BWIDth:THReshold?

Description Sets the bandwidth definition value. (command/query).
Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1112131415]161718]9}
<Mk>={[1112]131415]16171819110]11112]113114]115]16}
<response> the bandwidth definition value, the range varies

Parameter .
depending on the data format

Unit { dB (decibel) | ° (degree) | s (second) }

Query Response | <numeric>

Preset Value -3

Equivalent
Softkeys

Markers > Marker Math > Bandwidth Search > Bandwidth Value
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CALC:MARK:BWID:TYPE

CALCulate<Ch>[:SELected] :MARKer:BWIDth:TYPE <char>

CALCulate<Ch>[:SELected] :MARKer:BWIDth:TYPE?

Description Sets the type of the bandwidth search function (command/query).
Target The active trace of channel <Ch>,
<Ch>={[111213141516171819}
<char> specifies the type of the bandwidth:
Parameter BPASs : Bandpass
NOTCh :Notch
Out of Range The command is ignored.
Query Response | {BPAS|NOTC}

Preset Value

BPAS

Equivalent
Softkeys

Markers > Marker Math > Bandwidth Search > Type
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CALC:MARK:COUN

CALCulate<Ch>[:SELected] :MARKer:COUNt <numeric>

CALCulate<Ch>[:SELected] :MARKer :COUNt?

Description Sets the number of the turned ON markers (command/query).
Taraet The active trace of channel <Ch>,

9 <Ch>={[1]12131415/6]718]9}
Parameter <numeric>, range from 0 to 16
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0
Equivalent
Softkeys None

CALC:MARK:COUP

CALCulate<Ch>[:SELected] :MARKer:COUPle {ON|OFF|1]0}

CALCulate<Ch>[:SELected] :MARKer:COUPle?

Sets or reads out the ON/OFF state of the marker coupling function

Description (command/query).
Taraet All the traces of channel <Ch>,
9 <Ch>={[1]12131415/6]718]9}
{ON|1}  Marker coupling ON
Parameter
{OFF|0} Marker coupling OFF
Query Response | {01}
Preset Value 1

Equivalent
Softkeys

Marker > Properties > Marker Couple
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CALC:MARK:FUNC:DOM

CALCulate<Ch>[:SELected] :MARKer:FUNCtion:DOMain|[:STATe]

{ON|OFF |10}

CALCulate<Ch>[:SELected] :MARKer:FUNCtion:DOMain[:STATe]?

Sets or reads out the ON/OFF state of the marker search range

Description (command/query).
All traces of channel <Ch> (if the marker search range coupling is
Target set to ON by the CALC : MARK : FUNC: DOM: COUP command),
The active trace of channel <Ch> (if otherwise),
<Ch>={[1112131415]161718]9}
{ON|1}  Marker search range ON
Parameter
{OFF |0} Marker search range OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Markers > Marker Search > Search Range
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CALC:MARK:FUNC:DOM:STAR

CALCulate<Ch>[:SELected] :MARKer:FUNCtion:DOMain:STARt

<stimulus>

CALCulate<Ch>[:SELected] :MARKer:FUNCtion:DOMain:STARt?

Sets or reads out the start value of the marker search range

Description (command/query).
All traces of channel <Ch> (if the marker search range coupling is

Target set to ON by the CALC : MARK : FUNC : DOM: COUP command),
The active trace of channel <Ch> (if otherwise),
<Ch>={[1]112131415]161718]9}

Parameter <stimulus> the start value of the marker search

Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }

Query Response

<numeric>

Preset Value

3E5 (Planar - TR1300/1)
2E4 (TR5048)
2E4 (TR7530)

Equivalent
Softkeys

Markers > Marker Search > Search Start
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CALC:MARK:FUNC:DOM:STOP

CALCulate<Ch>[:SELected] :MARKer:FUNCtion:DOMain:STOP

<stimulus>

CALCulate<Ch>[:SELected] :MARKer:FUNCtion:DOMain:STOP?

Sets or reads out the stop value of the marker search range

Description (command/query).
All traces of channel <Ch> (if the marker search range coupling is
Target set to ON by the CALC : MARK : FUNC : DOM: COUP command),
The active trace of channel <Ch> (if otherwise),
<Ch>={[1]112131415]161718]9}
Parameter <stimulus> the stop value of the marker search
Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }
Query Response | <numeric>

Preset Value

1.3E9 (Planar - TR1300/1)
4.8E9 (TR5048)
3.0E9 (TR7530)

Equivalent
Softkeys

Markers > Marker Search > Search Stop
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CALC:MARK:FUNC:EXEC

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:EXECute

Executes the marker search according to the specified criterion. The
type of the marker search is set by the CAL.C : MARK: FUNC: TYPE

Description command.
(no query)
Marker <Mk> of the active trace of channel <Ch>,
Target <Ch>={[1]121314|5]6]1718]9}
<Mk>={[1]121314|5]6]1718]19110111112113|14|15|16}
Related CALC:MARK:FUNC:TYPE
Commands CALC:MARK:FUNC: DOM
Markers > Marker Search > { Maximum | Minimum }
Equivalent Markers > Marker Search > Peak > { Search Peak | Search Max Peak
Softkeys | Search Peak Left | Search Peak Right }

Markers > Marker Search > Target > { Search Target | Search Target
Left | Search Target Right }
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CALC:MARK:FUNC:PEXC

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:PEXCursion

<response>

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:PEXCursion?

Sets or reads out the peak excursion value, when the marker search

Description for peak is performed by the CALC :MARK : FUNC : EXEC command
(command/query).
Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1]121314|5|6]1718]9}
<Mk>={[1]12131415|6171819110|11|12|13|14|15|16}

Parameter <response> the peak excursion value, the range varies depending
on the data format

Unit { dB (decibel) | ° (degree) | s (second) }

Query Response | <numeric>

Preset Value 1

Equivalent
Softkeys

Markers > Marker Search > Peak > Peak Excursion
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CALC:MARK:FUNC:PPOL

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:PPOLarity <char>

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:PPOLarity?

Selects the peak polarity, when the marker search for peak is

Description performed by the CALC :MARK: FUNC : EXEC command
(command/query).

Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1112131415]161718]9}
<Mk>={[1]112]13141516171819110]111112]113114]15]16}
<char> specifies the peak polarity:

POSitive : Positive polarity

Parameter
NEGative : Negative polarity
BOTH : Both positive polarity and negative polarity

Out of Range The command is ignored.

Query Response | {POS|NEG|BOTH}

Preset Value POS

Related CALC:MARK: FUNC:EXEC

Commands

Equivalent Markers > Marker Search > Peak > Peak Polarity > { Positive |

Softkeys Negative | Both }
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CALC:MARK:FUNC:TARG

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:TARGet <response>

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:TARGet?

Sets or reads out the target value, when the marker search for target

Description is performed by the CALC:MARK: FUNC : EXEC command
(command/query).
Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1112131415]161718]9}
<Mk>={[1112]31415]16171819110]111112]113114]15]16}
< . .

Parameter response> the target value, the range varies depending on the
data format

Unit { dB (decibel) | ° (degree) | s (second) }

Query Response | <numeric>

Preset Value 0

Equivalent
Softkeys

Markers > Marker Search > Target > Target Value
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CALC:MARK:FUNC:TRAC

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:TRACking

{ON|OFF |10}

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:TRACking?

Sets or reads out the ON/OFF state of the marker search tracking

Description function (command/query).
Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1]12131415]16]1718]9}
<Mk>={[1]12131415|6171819110|11|12|13|14|15|16}
{ON|1}  Marker search tracking ON

Parameter
{OFF|0} Marker search tracking OFF

Query Response | {01}

Preset Value 0

Equivalent
Softkeys

Markers > Marker Search > Tracking
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CALC:MARK:FUNC:TTR

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:TTRansition

<char>

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:TTRansition?

Selects the type of the target transition, when the marker search for

Description transition is performed by the CALC : MARK : FUNC : EXEC command
(command/query).

Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1]12131415161718]9}
<Mk>={[1]112]13141516171819110]111112]113]114]15]16}
<char> specifies the type of the target transition:

POSitive : Positive target transition

Parameter NEGative : Negative target transition
BOTH : Both positive target transition and negative target

transition

Out of Range The command is ignored.

Query Response | {POS|NEG|BOTH}

Preset Value

POS

Related CALC:MARK:FUNC:EXEC

Commands

Equivalent Marker > Marker Search > Target > Target Transition > { Positive |
Softkeys Negative | Both }
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CALC:MARK:FUNC:TYPE

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:TYPE <char>

CALCulate<Ch>[:SELected] :MARKer<Mk>:FUNCtion:TYPE?

Selects the type of the marker search, which is performed by the

Description
CALC:MARK: FUNC:EXEC command (command/query).
Marker <Mk> the active trace of channel <Ch>,

Target <Ch>={[1]112131415]161718]9}
<Mk>={[1]112]13141516171819110]111112]113114]15]16}
<char> specifies the type of the marker search:
MAXimum : Maximum value search
MINimum : Minimum value search
PEAK : Peak search

Parameter LPEak : Peak search to the left from the marker
RPEak : Peak search to the right from the marker
TARGet : Target search
LTARget : Target search to the left from the marker
RTARget : Target search to the right from the marker

Out of Range The command is ignored.

Query Response | {MAX|MIN|PEAK|LPE |RPE|TARG|LTAR|RTAR}

Preset Value MAX

Related CALC:MARK: FUNC:EXEC

Commands
Markers > Marker Search > { Maximum | Minimum }

Eauivalent Markers > Marker Search > Peak > { Search Peak | Search Max Peak |

q Search Peak Left | Search Peak Right }

Softkeys

Markers > Marker Search > Target > { Search Target | Search Target
Left | Search Target Right }
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CALC:MARK:REF

CALCulate<Ch>[:SELected] :MARKer:REFerence [ :STATe] {ON|OFF|1]|0}

CALCulate<Ch>[:SELected] :MARKer:REFerence [ :STATe]?

Sets or reads out the ON/OFF state of the reference marker
(command/query).

Description When the reference marker is turned ON, all the values of the other
markers turn to relative values.

Taraet The active trace of channel <Ch>,

g <Ch>={[1112131415/61718]9}

{ON]1} Reference marker ON

Parameter
{OFF |0} Reference marker OFF

Query Response | {01}

Preset Value 0

Equivalent
Softkeys

Markers > Reference Marker
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CALC:MARK:SET
CALCulate<Ch>[:SELected] :MARKer<Mk>:SET <char>
. Sets the value of the specified item to the value of the position of

Description
the marker (no query).

Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1]121314151617181]9}
<Mk>={[1]1213141516171819110111(12113|14115|16}
<char> specifies the type of the marker search:

STARt : Sweep start value set to the stimulus value of the
marker position.
STOP : Sweep stop value set to the stimulus value of the

Parameter marker position.

CENTer : Sweep center value set to the stimulus value of the
marker position.

RLEVel : Reference value set to the response value of the
marker position.

Out of Range The command is ignored.

Equivalent Markers > Marker Functions > { Marker->Start | Marker->Stop |

Softkeys Marker ->Center | Marker->Ref Value }
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CALC:MARK:X

CALCulate<Ch>[:SELected] :MARKer<Mk>:X <stimulus>

CALCulate<Ch>[:SELected] :MARKer<Mk>:X?

Description Sets or reads out the stimulus value of the marker (command/query).
Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1112131415]161718]9}
<Mk>={[1]112]3141516171819110]111112]13]14]15]16}
<stimulus> the stimulus value of the marker, the range is from

Parameter . .
the stimulus start value to the stimulus stop value currently set

Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value

Stimulus center value

Equivalent
Softkeys

Markers > Edit Stimulus
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CALC:MARK:Y?

CALCulate<Ch>[:SELected] :MARKer<Mk>:Y?

Reads out the response value of the marker (query only).

If the reference marker is turned ON, the values of the markers from
1 to 15 are read out as relative values to the reference marker.

The data include 2 elements:

Description . . .
p <numeric 1> real number in rectangular format, real part in
polar and Smith chart formats;
<numeric 2> 0 in rectangular format, imaginary part in polar
and Smith chart formats.
Marker <Mk> of the active trace of channel <Ch>,
Target <Ch>={[1112131415]|6]1718]9}
<Mk>={[1]121314|5]61718]19110|11|12|13|14|15|16}
Query Response | <numeric 1>, <numeric 2>
Related CALC:MARK:REF
Commands
Equivalent
q None
Softkeys

CALC:MATH:DEL

CALCulate<Ch>[:SELected] :MATH:DELete

Description Removes the data (All memory traces) from the memory trace.
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]1213141516/7/8]9}
Equivalent
>
Softkeys Trace > Delete All Memory
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CALC:MATH:FUNC

CALCulate<Ch>[:SELected] :MATH:FUNCtion <char>

CALCulate<Ch>[:SELected] :MATH:FUNCtion?

Selects the math operation between the measurement data and the

Description memory trace data. The math result replaces the data trace. If the
data trace is not saved, the command is ignored (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1]121314151617181]9}
<char> specifies the math operation:
DIVide : Division Data / Mem.
MULTiply : Multiplication Data x Mem.
Parameter
ADD : Addition Data + Mem.
SUBTract : Subtraction Data — Mem.
NORMal :No math
Out of Range Error occurs. The command is ignored.
Query Response | {NORM|SUBT | DIV |ADD|MULT}
Preset Value NORM
Related CALC:MATH : MEM
Commands
Equivalent Trace > Data Math > { Data/Mem | Data*Mem | Data+Mem | Data-
Softkeys Mem | OFF }
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CALC:MATH:MEM

CALCulate<Ch>[:SELected] :MATH:MEMorize

. Saves the measurement data to the memory trace. Automatically

Description .
turns on the display the memory trace (no query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1]12131415161718]9}
Equivalent .
> > ->

Softkeys Trace > Display > Data->Memory

CALC:MST

CALCulate<Ch>[:SELected] :MSTatistics[:STATe] {ON|OFF|1]0}

CALCulate<Ch>[:SELected] :MSTatistics[:STATe]?

Sets or reads out the ON/OFF state of the math statistics display

Description (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1]12131415161718]9}
{ON]1} Statistics display ON
Parameter
{OFF |0} Statistics display OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Markers > Marker Math > Statistics > Statistics

92




Remote Control Commands

CALC:MST:DATA?

CALCulate<Ch>[:SELected] :MSTatistics:DATA?

Reads out the math statistics values (query only).

The statistics function is applied either over the whole range (for all
the trace), or within the range specified by CALC :MST : DOM
command (the range limits are determined by two markers).

The data include 3 elements:

Description .
<numeric 1> Mean value;
<numeric 2> Standard deviation;
<numeric 3>  Peak-to-peak (difference between the
maximum value and the minimum value).
Taraet The active trace of channel <Ch>,
g <Ch>={[1]121314]5/617189}
Query Response | <numeric 1>, <numeric 2>, <numeric 3>
Related CALC:MST:DOM
Commands
Equivalent
q None
Softkeys
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CALC:MST:DOM

CALCulate<Ch>[:SELected] :MSTatistics:DOMain|[:STATe]

{ON|OFF |10}

CALCulate<Ch>[:SELected] :MSTatistics:DOMain|[:STATe]?

Sets or reads out the ON/OFF state of the math statistics range

Description (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1112131415/61718]9}
{ON|1} Statistics range ON
Parameter
{OFF |0}  Statistics range OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Markers > Marker Math > Statistics > Statistics Range
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CALCMST:DOM:STAR

CALCulate<Ch>[:SELected] :MSTatistics:DOMain|[ :MARKer] : STARt

<numeric>

CALCulate<Ch>[:SELected] :MSTatistics:DOMain [ :MARKer] : STARtL?

Sets or reads out the number of the marker, which specifies the start

Description frequency of the math statistics range (command/query).

Target The a(itive trace of channel <Ch>,
<Ch>={[1]112131415]61718]9}

Parameter <numeric> marker number from 1 to 16

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value 1

Equivalent
Softkeys

Markers > Marker Math > Statistics > Statistics Start
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CALCMST:DOM:STOP

CALCulate<Ch>[:SELected] :MSTatistics:DOMain [ :MARKer] : STOP

<numeric>

CALCulate<Ch>[:SELected] :MSTatistics:DOMain|[ :MARKer] : STOP?

Sets or reads out the number of the marker, which specifies the stop

Description frequency of the math statistics range (command/query).

Target The a(itive trace of channel <Ch>,
<Ch>={[1]112131415]61718]9}

Parameter <numeric> marker number from 1 to 16

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value 2

Equivalent
Softkeys

Markers > Marker Math > Statistics > Statistics Stop
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CALC:PAR:COUN

CALCulate<Ch>:PARameter:COUNt <numeric>

CALCulate<Ch>:PARameter:COUNt?

Sets or reads out the number of traces in the channel

Description (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]61718]9}
Parameter <numeric> the number of the trace in the channel from 1 to 16
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 1
oot von
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CALC:PAR:DEF

CALCulate<Ch>:PARameter<Tr>:DEFine <char>

CALCulate<Ch>:PARameter<Tr>:DEFine?

Description

Sets the measurement parameter of the trace (command/query).

Target

Trace <Tr> of channel <Ch>,
<Tr>={[1]121314|5]6]7|8}
<Ch>={[1]1121314|5]6]1718]9}

Parameter

<char> specifies the measurement parameter:
S11 : 11 parameter

S21 :S21 parameter

A : Receiver A

B : Receiver B

R :Receiver R

Out of Range

Error occurs. The command is ignored..

Query Response

{S11|S21|A|IBIR}

Preset Value

Depends on the trace number.
Tr1,Tr5,Tr9,Tr 13 "S11”
Tr2,Tr6,Tr10,Tr 14 "S21"
Tr3,Tr7,Tr11,Tr 15 "S11"

Tr4,Tr8,Tr12,Tr16 "S21"

Equivalent
Softkeys

Response > Measurement > S11|S21

Response > Measurement > { Abs A | Abs B | AbsR }
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CALC:PAR:SEL

CALCulate<Ch>:PARameter<Tr>:SELect

Description Sets the active trace in channel <Ch> (no query).
Trace <Tr> of channel <Ch>,

Target <Tr>={[1]12]1314|5]16]7|8}
<Ch>={[1112131415]161718]9}
If the trace number is greater than the number of the traces

Notes displayed in the channel, an error occurs and the command is
ignored.

Related CALC:PAR:COUN

Commands

Equivalent .

quiv Trace > Active Trace
Softkeys
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CALC:PAR:SPOR

CALCulate<Ch>:PARameter<Tr>:SPORt <port>

CALCulate<Ch>:PARameter<Tr>:SPORt?

Sets or reads out the number of the receiver port, when performing

Description
P absolute measurements (command/query).

Trace <Tr> of channel <Ch>,
Target <Tr>={[111213141516|7|8}
<Ch>={[1]121314|5]6]1718]9}

Parameter <port> the number of the receiver port from 1 to 2

Out of Range Error occurs. The command is ignored..

Query Response | <numeric>

Preset Value 1

Equivalent

Softkeys Response > Measurement > { Abs A | Abs B }
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CALC:RLIM

CALCulate<Ch>[:SELected] :RLIMit[:STATe] {ON|OFF|1]0}

CALCulate<Ch>[:SELected] :RLIMit[:STATe]?

Sets or reads out the ON/OFF state of the ripple limit test

Description (command/query).
Taraet The active trace of channel <Ch>,
g <Ch>={[1112131415|6]1718]9}
{ON |1} Ripple limit test ON
Parameter
{OFF 10} Ripple limit test OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Ripple Limit > Ripple Test
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CALC:RLIM:DATA

CALCulate<Ch>[:SELected] :RLIMit:DATA <numeric list>

CALCulate<Ch>[:SELected] :RLIMit :DATA?

Sets the data array, which is the limit line for the ripple limit
function (command/query).

The array size is 1 + 4N, where N is the number of limit line
segments.

For the n-th point, where n from 1 to N:

<numeric 1> the number of limit line segments N is the
integer from O to 12. Setting O clears the
Llimit line.
Description <numeric 4n -2> type of the n-th limit line segment
e 0:Off.
e 1:0n
<numeric 4n-1>  the stimulus value in the beginning point of
the n-th segment
<numeric 4n-0> the stimulus value in the end point of the
n-th segment
<numeric 4n+1> the ripple limit value of the n—th segment
Taraet The active trace of channel <Ch>,
g <Ch>={[1]1213141516/718]9}
<numeric 1>, <numeric 2>, .<numeric 4N+1>
Query Response The data transfer format depends on the FORM: DATA command
setting.
If the array size is not 1 + 4N, where N is <numeric 1>, an error
occurs. If <numeric 4n-2>is less than O or more than 1, an error
Notes occurs. When <numeric 4n-1>, <numeric 4n-0>, and
<numeric 4n+1> elements are out of allowable range, the value
is set to the limit, which is closer to the specified value.
Related FORM:DATA
Commands
Equivalent Analysis > Ripple Limit > Edit Ripple Limit
Softkeys y PP PP
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CALC:RLIM:DISP:LINE

CALCulate<Ch>[:SELected] :RLIMit:DISPlay:LINE {ON|OFF|1]|0}

CALCulate<Ch>[:SELected] :RLIMit:DISPlay:LINE?

Sets or reads out the ON/OFF state of the ripple limit line display

Description (command/query).
Taraet Active trace of channel <Ch>,
g <Ch>={[1]1213141516171819}
{ON |1} Ripple limit line ON
Parameter
{OFF|0} Ripple limit line OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Ripple Limit > Limit Line

CALC:RLIM:FAIL?

CALCulate#[:SELected] :RLIMit :FAIL?

Description Reads out the ripple limit test result (query only).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
1 Fail
Query Response
0 Pass
Equivalent
Softkeys None
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CALC:RLIM:REP?

CALCulate<Ch>[:SELected] :RLIMit:REPort[:DATA]?

Reads out the data array, which is the ripple limit test results (query
only).

The array size is 1+3N, where N is the number of ripple limit bands.
For the n-th point, where n from 1 to N:

<numeric 1> N total number of the bands
Description .
p <numeric 3n-1> n number of the band
<numeric 3n-0> Ripple value in the n-th band
<numeric 3n+1> Ripple limit test result in the n-th band:
e 0: Pass
e 1: Fail
Taraet The active trace of channel <Ch>,
9 <Ch>={[1112131415/617181]9}
<numeric 1>, <numeric 2>, .<numeric 3N+1>
Query Response The data transfer format depends on the FORM: DATA command
setting.
Related FORM: DATA
Commands
Equivalent
q None
Softkeys
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CALC:SMO

CALCulate<Ch>[:SELected] : SMOothing[:STATe] {ON|OFF|1|0}

CALCulate<Ch>[:SELected] : SMOothing[:STATe]?

Sets or reads out the ON/OFF state of the trace smoothing function

Description (command/query).
Taraet Active trace of channel <Ch>,
g <Ch>={[1]12131415161718]9}
{ON|1}  Trace smoothing ON
Parameter
{OFF|0} Trace smoothing OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Response > Smoothing
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CALC:SMO:APER

CALCulate<Ch>[:SELected] : SMOothing:APERture <numeric>

CALCulate<Ch>[:SELected] : SMOothing:APERture?

Sets or reads out the smoothing aperture, when performing

Description smoothing function (command/query).

Target Active trace of channel <Ch>,
<Ch>={[1]112131415]61718]9}

Parameter <numeric> the smoothing aperture from 0.01 to 20

Unit % (percent)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value 1

Equivalent

Softkeys Response > Smo Aperture
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CALC:TRAC:DATA:FDAT?

CALCulate<Ch>:TRACe<Tr>:DATA:FDATa?

Reads out the formatted data array (query only).

The formatted data array is the data, whose processing is completed
including the formatting as the last step. Such data represent the
data trace values as they are shown on the screen.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

Description
<numeric 2n-1>  real number in rectangular format, real part
in polar and Smith chart formats;
<numeric 2n> 0 in rectangular format, imaginary part in
polar and Smith chart formats.
The specified trace <Tr> of channel <Ch>,
Target <Tr>={[1112|3141516|7|8}
<Ch>={[1]121314|5]6]1718]9}
<numeric 1>, <numeric 2>, ..<numeric 2N>
Query Response The data transfer format depends on the FORM: DATA command
setting.
Related CALC:DATA:FDAT
Commands
Equivalent
q None
Softkeys
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CALC:TRAC:DATA:FMEM?

CALCulate<Ch>:TRACe<Tr>:DATA:FMEMory?

Reads out the formatted memory array (query only).

The formatted memory array is the data, whose processing is
completed including the formatting as the last step. Such data
represent the memory trace values as they are shown on the screen.
The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

Description
<numeric 2n-1>  real number in rectangular format, real part
in polar and Smith chart formats;
<numeric 2n> 0 in rectangular format, imaginary part in
polar and Smith chart formats.
The specified trace <Tr> of channel <Ch>,
Target <Tr>={[1112|3141516|7|8}
<Ch>={[1112131415|6]718]9}
<numeric 1>, <numeric 2>, ..<numeric 2N>
Query Response The data transfer format depends on the FORM: DATA command
setting.
Notes If the memory is empty, an error occurs and the command is
ignored.
Related CALC :DATA: FMEM
Commands
Equivalent
q None
Softkeys
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CALC:TRAC:DATA:SDAT?

CALCulate<Ch>:TRACe<Tr>:DATA:SDATa?

Reads out the corrected data array (query only).

The corrected data array is the data, whose processing is completed
excluding the formatting as the last step. Such data represent S-
parameter complex values.

The array size is 2N, where N is the number of measurement points.

Description For the n—th point, where n from 1 to N:
<numeric 2n-1> the real part of corrected measurement;
<numeric 2n> the imaginary part of corrected

measurement.

The specified trace <Tr> of channel <Ch>,

Target <Tr>={[1]112131415161718}
<Ch>={[1112131415]|6]1718]9}
<numeric 1>, <numeric 2>, .<numeric 2N>

Query Response The data transfer format depends on the FORM: DATA command
setting.

Related CALC:DATA: SDAT

Commands

Equivalent

q None
Softkeys
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CALC:TRAC:DATA:SMEM?

CALCulate<Ch>:TRACe<Tr>:DATA:SMEMory?

Reads out the corrected memory array (query only).

The corrected memory array is the data, whose processing is
completed excluding the formatting as the last step. Such data
represent S—parameter complex values.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

Description
<numeric 2n-1> the real part of corrected measurement
memory;
<numeric 2n> the imaginary part of corrected measurement
memory.
The specified trace <Tr> of channel <Ch>,
Target <Tr>={[1112|3141516|7|8}
<Ch>={[1]12131415161718]9}
<numeric 1>, <numeric 2>, ..<numeric 2N>
Query Response The data transfer format depends on the FORM: DATA command
setting.
Notes If the memory is empty, an error occurs and the command is
ignored.
Related CALC:DATA : SMEM
Commands
Equivalent
q None
Softkeys
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CALC:TRAN:TIME

CALCulate<Ch>[:SELected] :TRANsform:TIME[:TYPE] <char>

CALCulate<Ch>[:SELected] :TRANsform:TIME [ : TYPE] ?

Selects the transformation type for the time domain transformation

Description function: bandpass response or direct current circuit
(command/query).

Target The aitive trace of channel <Ch>,
<Ch>={[1]112131415]161718]9}
<char>specifies the transformation type:

Parameter BPASs : Bandpass
LPASs : Lowpass

Out of Range The command is ignored.

Query Response | {BPAS|LPAS}

Preset Value

BPAS

Equivalent
Softkeys

Analysis > Time Domain > Response Type > { Bandpass | Lowpass
Step | Lowpass Impulse }
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CALC:TRAN:TIME:CENT

CALCulate<Ch>[:SELected] : TRANsform: TIME:CENTer <time>

CALCulate<Ch>[:SELected] :TRANsform: TIME :CENTer?

Sets or reads out the time domain center value, when the time

Description . . L
P domain transformation function is turned ON (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<time> the time domain center value, the range varies depending
Parameter . .
on the specified frequency range and the number of points
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 1

Equivalent
Softkeys

Analysis > Time Domain > Center
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CALC:TRAN:TIME:IMP:WIDT

CALCulate<Ch>[:SELected] : TRANsform:TIME: IMPulse:WIDTh <time>

CALCulate<Ch>[:SELected] :TRANsform:TIME: IMPulse:WIDTh?

Sets or reads out the impulse width (time domain transformation
resolution), coupled with the Kaiser-Bessel window shape 3

Description parameter. The impulse width setting changes the 3 parameter, and
setting of B parameter changes the impulse width (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<time> the impulse width, the range varies depending on the
Parameter . ;
specified frequency range and the number of points
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Equivalent Analysis > Time Domain > Window > Impulse Width (when the
Softkeys transformation type is set to Bandpass or Lowpass Impulse)
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CALC:TRAN:TIME:KBES

CALCulate<Ch>[:SELected] :TRANsform: TIME :KBESsel <numeric>

CALCulate<Ch>[:SELected] :TRANsform: TIME:KBESsel?

Sets or reads out the B parameter, which controls the Kaiser-Bessel

Description window shape, when performing time domain transformation
(command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
Parameter <numeric> 3 parameter from 0 to 13
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 6

Equivalent
Softkeys

Analysis > Time Domain > Window > Kaiser Beta

CALC:TRAN:TIME:LPFR

CALCulate<Ch>[:SELected] :TRANsform:TIME: LPFRequency

. Changes the frequency range to match with the lowpass type of the
Description . . . .
time domain transformation function (no query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]12131415/6]718]9}
Equivalent Analysis > Time Domain > Set Frequency Low Pass
Softkeys ¥ 9 Y
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CALC:TRAN:TIME:REFL:TYPE

CALCulate<Ch>[:SELected] :TRANsform: TIME :REFLection:TYPE <char>

CALCulate<Ch>[:SELected] :TRANsform: TIME:REFLection:TYPE?

Selects the reflection distance either one way or round trip for the

Description time domain transformation function.
(command/query)

Target The active trace of channel <Ch>,
<Ch>={[111213141516171819}
<char> Choose from:

Parameter RTRip :Round Trip
OWAY : One Way

Query Response | {RTR|OWAY }

Preset Value RTR

Equivalent
Softkeys

Analysis > Time Domain > Reflection Type > Round Trip | One Way
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CALC:TRAN:TIME:SPAN

CALCulate<Ch>[:SELected] : TRANsform:TIME: SPAN <time>

CALCulate<Ch>[:SELected] :TRANsform: TIME : SPAN?

Sets or reads out the time domain span value, when the time

Description domain transformation function is turned ON (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<time> the time domain span value, the range varies depending
Parameter . .
on the specified frequency range and the number of points
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 2e-8

Equivalent
Softkeys

Analysis > Time Domain > Span
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CALC:TRAN:TIME:STAR

CALCulate<Ch>[:SELected] : TRANsform:TIME: STARt <time>

CALCulate<Ch>[:SELected] :TRANsform: TIME: STARt?

Sets or reads out the time domain start value, when the time

Description . . L
P domain transformation function is turned ON (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<time> the time domain start value, the range varies depending on
Parameter - .
the specified frequency range and the number of points
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value -le-8

Equivalent
Softkeys

Analysis > Time Domain > Start
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CALC:TRAN:TIME:STAT

CALCulate<Ch>[:SELected] :TRANsform: TIME: STATe {ON|OFF |10}

CALCulate<Ch>[:SELected] :TRANsform: TIME: STATe?

Sets or reads out the ON/OFF state of the time domain

Description transformation function (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[11121314|5]6]17|8]9}

{ON]1} Time domain transformation ON
Parameter

{OFF |0} Time domain transformation OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Time Domain > Time Domain
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CALC:TRAN:TIME:STEP:RTIM

CALCulate<Ch>[:SELected] :TRANsform:TIME: STEP:RTIMe <time>

CALCulate<Ch>[:SELected] :TRANsform: TIME: STEP:RTIMe?

Sets or reads out the rise time of the step signal (time domain
transformation resolution), coupled with the Kaiser-Bessel window

Description shape 3 parameter. The impulse width setting changes the B
parameter, and setting of B parameter changes the impulse width
(command/query).

Taraet The active trace of channel <Ch>,

9 <Ch>={[1]112131415/6]718]9}
<time> the impulse width, the range varies depending on the

Parameter e .
specified frequency range and the number of points

Unit s (second)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Equivalent Analysis > Time Domain > Window > Impulse Width (when the

Softkeys transformation type is set to Lowpass Step)
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CALC:TRAN:TIME:STIM

CALCulate<Ch>[:SELected] : TRANsform: TIME:STIMulus <char>

CALCulate<Ch>[:SELected] :TRANsform: TIME: STIMulus?

Selects the stimulus type for the time domain transformation

Description function: impulse or step (command/query).

Target The active trace of channel <Ch>,
<Ch>={[1]112131415]161718]9}
<char> specifies the stimulus type:

Parameter IMPulse : Impulse
STEP : Step

Out of Range The command is ignored.

Query Response | {IMP|STEP}

Preset Value IMP

Equivalent
Softkeys

Analysis > Time Domain > Response Type > { Bandpass | Lowpass
Step | Lowpass Impulse }
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CALC:TRAN:TIME:STOP

CALCulate<Ch>[:SELected] : TRANsform: TIME: STOP <time>

CALCulate<Ch>[:SELected] :TRANsform: TIME: STOP?

Sets or reads out the time domain stop value, when the time domain

Description . L
P transformation function is turned ON (command/query).
Taraet The active trace of channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<time> the time domain stop value, the range varies depending on
Parameter - .
the specified frequency range and the number of points
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value +1le-8

Equivalent
Softkeys

Analysis > Time Domain > Stop
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CALC:TRAN:TIME:UNIT

CALCulate<Ch> [:SELected] :TRANsform:TIME:UNIT <char>

CALCulate<Ch> [:SELected] :TRANsform:TIME:UNIT?

Selects the the transformation unit for the time domain
Description transformation function: seconds, meters, feet.
(command/query)

The active trace of channel <Ch>,

Target <Ch>={[1]1213141516171819}
<char> choose from:
SEC : Seconds
Parameter
MET : Meters
FEET : Feet

Query Response {SEC|MET | FEET}

Preset Value SEC

Equivalent

is>Ti in > Unit > Ti i ;
Softkeys Analysis > Time Domain > Unit > Time, ns | Metric, m | Imperial, ft
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DISP:COL:BACK

DISPlay:COLor:BACK <numeric 1>,<numeric 2>,<numeric 3>

DISPlay:COLor :BACK?

. Sets or reads out the background color for trace display
Description

(command/query).
<numeric 1> Red value R from O to 255;
Parameter <numeric 2> Green value G from O to 255;
<numeric 3> Blue value B from 0 to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric 1>, <numeric 2>, <numeric 3>

Preset Value 0, 0, O

Equivalent

Softkeys Display > Color > Background
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DISP:COL:GRAT

DISPlay:COLor:GRATicule <numeric 1>,<numeric 2>,<numeric 3>

DISPlay:COLor:GRATicule?

Sets or reads out the grid and the graticule label color for trace

Description display (command/query).
<numeric 1> Red value R from 0 to 255;
Parameter <numeric 2> Green value G from O to 255;
<numeric 3> Blue value B from 0 to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric 1>, <numeric 2>, <numeric 3>

Preset Value

160, 160, 164

Equivalent . .
Softkeys Display > Color > Grid
DISP:COL:RES

DISPlay:COLor:RESet

Description Restores the display settings to the default values (no query).
Equivalent .

>
Softkeys Display > Set Defaults
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DISP:COL:TRAC:DATA

DISPlay:COLor:TRACe<Tr>:DATA <numeric 1>,<numeric 2>,

<numeric 3>

DISPlay:COLor:TRACe<Tr>:DATA?

Description Sets or reads out the data trace color (command/query).
Target Trace <Tr>,
<Tr>={[1]112]31415]16|7]8}
<numeric 1> Red value R from 0 to 255;
Parameter <numeric 2> Green value G from O to 255;
<numeric 3> Blue value B from 0 to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric 1>, <numeric 2>, <numeric 3>

Preset Value

Varies depending on the trace number.

Equivalent
Softkeys

Display > Color > Data Trace
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DISP:COL:TRAC:MEM

DISPlay:COLor:TRACe<Tr>:MEMory <numeric 1>,<numeric 2>,

<numeric 3>

DISPlay:COLor:TRACe<Tr>:MEMory?

Description Sets or reads out the memory trace color (command/query).
Target Trace <Tr>,

<Tr>={[1]112]31415]16|7]8}

<numeric 1> Red value R from O to 255;
Parameter <numeric 2> Green value G from O to 255;

<numeric 3> Blue value B from 0 to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric 1>, <numeric 2>, <numeric 3>

Preset Value

Varies depending on the trace number.

Equivalent .
Softkeys Display > Color > Memory Trace
DISP:ENAB

DISPlay:ENABle {OFF|ON|O|1}

DISPlay:ENABle?

Description Turns ON/OFF the display update (command/query).
{ON|1} ON

Parameter
{OFF|10}  OFF

Query Response | {01}

Preset Value 1

Equivalent .

Softkeys Display > Update
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DISP:FSIG

DISPlay:FSIGn {ON|OFF |10}

DISPlay:FSIGn?

Sets or reads out the ON/OFF state of the Fail sign display, when

Description performing limit test or ripple limit test (command/query).
{ON|1} Fail sign display ON

Parameter
{OFF 10}  Fail sign display OFF

Query Response | {01}

Preset Value 0

Equivalent Analysis > Limit Test > Fail Sign
Softkeys Analysis > Ripple Limit > Fail Sign
DISP:IMAG

DISPlay:IMAGe <char>

DISPlay:IMAGe?

Sets or reads out the inverted color display of the data traces

Description (command/query).
<char> choose from:
Parameter NORMal :Normal display
INVert : Inverted color display
Out of Range The command is ignored.
Query Response | {NORM|INV}
Preset Value NORM

Equivalent
Softkeys

Display > Invert Color
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SYST:HIDE
SYSTem:HIDE
Description Hides the instrument GUI (no query).
Related SYST:SHOW
Commands
Equivalent
Softkeys None

SYSTem:SHOW

DISPlay:SHOW

I Shows the instrument GUI hidden by the SYST : HIDE command (no
Description
query).
Related SYST:HIDE
Commands
Equivalent
Softkeys None
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DISP:MAX

DISPlay:MAXimize {ON|OFF|1|0}

DISPlay:MAXimize?

Sets or reads out the ON/OFF state of the window maximization of

Description the active channel (command/query).
{ON]1} Maximization ON
Parameter
{OFF |0} Maximization OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Channel > Maximize Channel

DISP:SPL

DISPlay:SPLit <numeric>

DISPlay:SPLit?

Sets or reads out the layout of the channel windows on the screen

Description (command/query).
The channel window layout on the screen see below.
<numeric> the number of the channel window layout from 1 to
Parameter
10
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 1

Equivalent
Softkeys

Channel > Allocate Channels
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Channel window layout on the screen

Remote Control Commands
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DISP:UPD

DISPlay:UPDate[:IMMediate]

Updates the display once, when the display update is set to OFF by

Description the DISP:ENAB command. (no query).
Related DISP:ENAB

Commands

Equivalent

Softkeys None
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DISP:WIND:ACT

DISPlay:WINDow<Ch>:ACTivate

Description Sets the active channel (no query).

Channel <Ch>,

Target <Ch>={[1]12131415161718]9}

At attempt to set to the active channel the channel, which is not

Notes displayed by the DISP: SPL command, an error occurs.
Related DISP:SPL

Commands

Equivalent Channel > Active Channel

Softkeys
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DISP:WIND:ANN:MARK:ALIG

DISPlay:WINDow<Ch>:ANNotation:MARKer:ALIGn[:TYPE]

DISPlay:WINDow<Ch>:ANNotation:MARKer:ALIGn[:TYPE]?

<char>

Sets or reads out the alignment mode of the marker display position
of each trace, when the only active trace display feature is turned

Description OFF by the DISP:WIND:ANN:MARK:SING command
(command/query).

Taraet Channel <Ch>,

9 <Ch>={[1]12131415/61718]9}

<char> choose from:
VERTical : Vertical alignment

Parameter
HORizontal  :Horizontal alignment
NONE :No alignment

Out of Range The command is ignored.

Query Response | {NONE | VERT | HOR}

Preset Value NONE
Related DISP:WIND:ANN:MARK:SING
Commands
Equivalent . . ) )
> > >
Softkeys Markers > Properties > Align > { Vertical | Horizontal | OFF }
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DISP:WIND:ANN:MARK:SING

DISPlay:WINDow<Ch>:ANNotation:MARKer:SINGle[:STATe]

{ON|OFF |10}

DISPlay:WINDow<Ch>:ANNotation:MARKer:SINGle[:STATe]?

Sets or reads out the ON/OFF state of the marker display for the

Description active trace only (command/query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
{ON|1}  Only active trace markers display ON
Parameter
{OFF|0} Only active trace markers display OFF
Query Response | {01}
Preset Value 1

Equivalent ) )
Softkeys Markers > Properties > Active Only
DISP:WIND:MAX

DISPlay:WINDow<Ch>:MAXimize {ON|OFF|1]|0}

DISPlay:WINDow<Ch>:MAXimize?

Sets or reads out the ON/OFF state of the active trace maximization

Description of the specified channel (command/query).
{ON]| 1} Maximization ON

Parameter
{OFF |0} Maximization OFF

Query Response | {01}

Preset Value 0

Equivalent
Softkeys

Trace > Maximize Trace
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DISP:WIND:SPL

DISPlay:WINDow<Ch>:SPLit <numeric>

DISPlay:WINDow<Ch>:SPLit?

Sets or reads out the layout of the graph in the channel window

Description (command/query).
The graph layout in the channel window see below.
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/6]718]9}
Parameter <numeric> the number of the graph layout from 1 to 9
Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value 1

Equivalent

T >A T
Softkeys race > Allocate Traces

Graph layout in the channel window

vl 2 el s el L] v el
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DISP:WIND:TITL

DISPlay:WINDow<Ch>:TITLe[:STATe]

{ON|OFF |10}

DISPlay:WINDow<Ch>:TITLe[:STATe]?

Sets or reads out the ON/OFF state of the channel title display

Description (command/query).
Taraet Channel <Ch>,
9 <Ch>={[1]1213141516]71819}
{ON|1} Channel title display ON
Parameter
{OFF |0} Channel title display OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Display > Title Label

DISP:WIND:TITL:DATA

DISPlay:WINDow<Ch>:TITLe:DATA <string>

DISPlay:WINDow<Ch>:TITLe:DATA?

Description Sets or reads out the channel title label (command/query).
Target Channel <Ch>,
<Ch>={[111213141516171819}
Parameter <string>, up to 256 characters (quoted string)
Query Response | <string>
Preset Value "
T e
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DISP:WIND:TRAC:ANN:MARK:MEM

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer:MEMory <bool>

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer:MEMory?

Description Turns ON/OFF the state of the memory value display on the marker.
Trace <Tr> of channel <Ch>,

Target <Tr>={[1112]31415|6]718}
<Ch>={[111213141516171819}
<bool> Specifies the memory value display:

Parameter {ON|1} ON
{OFF |0} OFF

Query Response | {01}

Preset Value 0

Equivalent
Softkeys

Markers > Properties > Memory Value
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DISP:WIND:TRAC:ANN:MARK:POS:X

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer:POSition:X

<numeric>

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer:POSition:X?

Sets or reads out the display position of the marker value on the X-

Description axis by a percentage of the display width (command/query).
Trace <Tr> of channel <Ch>,
Target <Tr>={[111213141516|7|8}
<Ch>={[1]12131415161718]9}
<numeric> the display position of the marker value on the X-axis
Parameter
from O to 100
Unit % (percent)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Markers > Properties > Data X Position
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DISP:WIND:TRAC:ANN:MARK:POS:Y

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer:POSition:Y

<numeric>

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer:POSition:Y?

Sets or reads out the display position of the marker value on the Y-

Description axis by a percentage of the display height (command/query).
Trace <Tr> of channel <Ch>,
Target <Tr>={[111213141516|7|8}
<Ch>={[1]12131415161718]9}
<numeric> the display position of the marker value on the Y-axis
Parameter
from O to 100
Unit % (percent)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Markers > Properties > Data Y Position

DISP:WIND:TRAC:Y:AUTO

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe] :AUTO

Description Executes the auto scale function for the trace (no query).
Trace <Tr> of channel <Ch>,
Target <Tr>={[1]1121314|5|6]7|8}
<Ch>={[1]12131415161718]9}
Equivalent
>
Softkeys Scale > Auto Scale
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DISP:WIND:TRAC:Y:PDIV

Remote Control Commands

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe] :PDIVision <response>

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe] :PDIVision?

Sets or reads out the trace scale. Sets the scale per division, when

Description the data format is the rectangular format. Sets the full scale value,
when the data format is the Smith chart format or the polar format.
Trace <Tr> of channel <Ch>,

Target <Tr>={[1]121314|5]1617|8}
<Ch>={[1]12131415161718]9}

Parameter <response> the scale value from 10E-18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value

Varies depending on the format.

Logarithmic Magnitude:
Phase:

Expand Phase:

Group Delay:

Smith Chart, Polar, SWR:

Linear Magnitude:

Real part, Imaginary part:

10 dB/Div
40 °/Div
100 °/Div
10e-9 s/Div
1 /Div

0.1 /Div

0.2 /Div

Equivalent
Softkeys

Scale > Scale
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DISP:WIND:TRAC:Y:RLEV

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe] :RLEVel <response>

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe] :RLEVel?

Sets the value of the reference line (response value on the reference

Description line). For the rectangular format only (command/query).
Trace <Tr> of channel <Ch>,

Target <Tr>={[111213141516|7|8}
<Ch>={[1]12131415161718]9}

Parameter <response> the reference value from 10E-18 to 1E18

Unit { dB (decibel) | ° (degree) | s (second) }

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value

0 (except for SWR: 1)

Equivalent
Softkeys

Scale > Ref Value
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DISP:WIND:TRAC:Y:RPOS

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe] :RPOSition <numeric>

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe] :RPOSition?

Sets the position of the reference line. For the rectangular format

Description only (command/query).
Trace <Tr> of channel <Ch>,
Target <Tr>={[111213141516|7|8}
<Ch>={[1]112131415]61718]9}
<numeric> the reference line position from 0 to the number of the
Parameter scale divisions (set by the DISP:WIND:Y:DIV command, 10 by
default)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>

Preset Value

5 (except for SWR: 0)

Equivalent
Softkeys

Scale > Ref Position
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DISP:WIND:Y:DIV

DISPlay:WINDow<Ch>:Y[:SCALe] :DIVisions <numeric>

DISPlay:WINDow<Ch>:Y[:SCALe] :DIVisions?

Sets the number of the vertical scale divisions. For the rectangular

Description format only (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415161718]9}
Parameter <numeric> the number of the vertical scale divisions from 4 to 30
Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value 10
Resolution 2
Equivalent

Softkeys Scale > Divisions
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FORM:BORD

FORMat : BORDer <char>

FORMat : BORDer?

Sets or reads out the transfer order of each byte in data, when the

Description binary data transfer format is set by the FORM: DATA command
(command/query).
<char> choose from:

Parameter NORMal :Normal (from the most significant byte)
SWAPped : Swapped (from the least significant byte)

Out of Range The command is ignored.

Query Response | {NORM|SWAP}

Preset Value NORM

oot von
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FORM:DATA

FORMat :DATA <char>

FORMat :DATA?

Sets or reads out the data transfer format, when responding to the
following queries:

CALC:DATA:FDAT?

CALC:DATA:FMEM?

CALC:DATA:SDAT?

CALC:DATA: SMEM?

CALC:FUNC:DATA?

CALC:LIM:DATA?

Description CALC:LIM:REP?
CALC:LIM:REP:ALL?
CALC:RLIM:DATA?
CALC:RLIM:REP?
SENS:FREQ:DATA?
SENS:SEGM:DATA?
(command/query)
<char> choose from:
ASCii : Character format
Parameter
REAL : Binary format (IEEE-64 floating point)
REAL32 : Binary format (IEEE-32 floating point)
Out of Range The command is ignored.
Query Response | {ASC|REAL|REAL32}
Preset Value ASC
Related FORM:BORD
Commands
Equivalent
Softkeys None
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HCOP
HCOPy[:IMMediate]
Description Prints out the image displayed on the screen without previewing (no
query).
Equivalent System > Print > Print Embedded
Softkeys y
HCOP:ABOR
HCOPy : ABORt
Description Aborts the printout (no query).
Equivalent
Softkeys None
HCOP:DATE:STAM

HCOPy:DATE:STAMp {ON|OFF|1]0}

HCOPy:DATE : STAMp?

Sets or reads out the ON/OFF state of the current date and time

Description printout in the upper right corner (command/query).
{ON|1} Date & time printout ON

Parameter
{OFF|0} Date & time printout OFF

Query Response | {01}

Preset Value 1

Equivalent
Softkeys

System > Print > Print Date & Time
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HCOP:IMAG

HCOPy:IMAGe <char>

HCOPy:IMAGe?

Sets or reads out the inverted color image printout

Description (command/query).
<char> choose from:

Parameter NORMal :Normal printout
INVert : Inverted color printout

Out of Range The command is ignored.

Query Response | {NORM|INV}

Preset Value NORM

Equivalent .

Softkeys System > Print > Invert Image

HCOP:PAIN

HCOPy:PAINt <char>

HCOPy:PAINt?

Sets or reads out the color chart for the image printout

Description (command/query).
<char> choose from:
COLor : Color printout
Parameter
GRAY : Grayscale printout
BW : Black&white printout
Out of Range The command is ignored.
Query Response | {COL|GRAY |BW}
Preset Value BW
ngl;g:;jnt System > Print > Print Color

146




INIT

Remote Control Commands

INITiate<Ch>[:IMMediate]

Sets the channel to the single trigger mode. Before this command is
sent, the channel must be in hold state, otherwise an error occurs
and the command is ignored.

Description On completion of the sweep, the channel goes back into the hold
state.
The command is completed before the end of the sweep.
(no query)

Taraet Channel <Ch>,

9 <Ch>={[1112131415/6]7/819}

The sweep start in single trigger mode depends on the trigger
source. If the trigger is set to internal, the sweep will start

Notes . . . S . .
immediately upon the single mode activation. If the trigger is set
otherwise, the sweep will start when the trigger signal is received.

Related TRIG:SOUR

Commands

Equivalent . . .

> >
Softkeys Stimulus > Trigger > Single
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INIT:CONT

INITiate<Ch>:CONTinuous {ON|OFF|1|0}

INITiate<Ch>:CONTinuous?

Sets or reads out the ON/OFF state of the continuous trigger

Description initiation mode. If the continuous trigger initiation mode is set to
OFF, the channel tuns to the hold state (command /query).

Taraet Channel <Ch>,

g <Ch>={[1]121314151617181]9}

{ON|1} Continuous trigger initiation mode ON

Parameter
{OFF |0} Continuous trigger initiation mode OFF

Query Response | {01}

Preset Value 1

The sweep start in continuous trigger initiation mode depends on
the trigger source. If the trigger is set to internal, the sweeps will go

Notes immediately one after another. If the trigger is set otherwise, the
sweep will start when the trigger signal is received.
Related TRIG: SOUR
Commands
Equivalent Stimulus > Trigger > Continuous
Softkeys Stimulus > Trigger > Hold
MMEM:COPY

MMEMory:COPY <stringl>,<string2>

Description Copies a file (no query).

<stringl> Source file name (quoted string)
Parameter

<string2> Destination file name (quoted string)
Equivalent
Softkeys None
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MMEM:DEL
MMEMory:DELete <string>
Description Deletes a file (no query).
Parameter <string> File name (quoted string)
Equivalent
Softkeys None
MMEM:LOAD

MMEMory:LOAD[ :STATe] <string>

Recalls the specified instrument state file. The file must be saved by

Description
the MMEM: STOR command (no query).

Parameter <string> File name (quoted string)

If the full path of the file is not specified, the \State subdirectory of
Notes the main directory will be searched for the file. The instrument state
file has *.sta extension by default.

Equivalent

> >
Softkeys System > Save/Recall > State
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MMEM:LOAD:CHAN

MMEMory:LOAD:CHANnel [ : STATe] <char>

Recalls the instrument state for the active channel. The file must be

Description saved in one of the four memory registers by the
MMEM: STOR : CHAN command (no query).

Target Active channel set by the DISP:WIND:ACT command
<char> choose from:
A :Recall from register A

Parameter B : Recall from register B
C : Recall from register C
D : Recall from register D

Out of Range The command is ignored.

gzjﬁ;’kve";”t System > Save/Recall > Channel { State A|B| C|D }

MMEM:LOAD:CKIT

MMEMory:LOAD:CKIT<Ck> <string>

Description Recalls the definition file for the calibration kit. The file must be
P saved by the MMEM:STOR:CKIT command (no query).
Taraet Calibration kit <Ck>,
g <Ck>={[1]11213141516171819110]11}

Parameter <string> Fine name (quoted string)
If the full path of the file is not specified, the \CalKit subdirectory of

Notes the main directory will be searched for the file. The calibration kit
definition file has *.ckd extension by default.

Equivalent

Softkeys None
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MMEM:LOAD:LIM

MMEMory:LOAD:LIMit <string>

Recalls the limit table file. The file must be saved by the

Description

MMEM: STOR: LIM command (no query).

Active trace of the active channel, set by the CALC: PAR: SEL
Target

command
Parameter <string> File name (quoted string)

If the full path of the file is not specified, the \Limit subdirectory of
Notes the main directory will be searched for the file. The limit table file
has *.lim extension by default.

Equivalent

Analysis > Limit Test > Edit Limit Line > Restore Limit Table
Softkeys
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MMEM:LOAD:RLIM

MMEMory:LOAD:RLIMit <string>

Recalls the ripple limit table file. The file must be saved by

Description
MMEM: STOR : RLIM the command (no query).
Active trace of the active channel, set by the CALC: PAR: SEL
Target
command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Limit subdirectory of
Notes the main directory will be searched for the file. The ripple limit file
has *.rlm extension by default.
Equivalent Analysis > Ripple Limit > Edit Ripple Limit > Restore Ripple Limit
Softkeys Table

MMEM:LOAD:SEGM

MMEMory:LOAD: SEGMent <string>

. Recalls the segment table file. The file must be saved by the
Description
MMEM: STOR : SEGM command (no query).
Target Active channel, set by the DISP:WIND:ACT command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Segment subdirectory
Notes of the main directory will be searched for the file. The segment file
has *.seg extension by default.
Equivalent Stimulus > Segment Table > Recall
Softkeys g
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MMEM:MDIR
MMEMory:MDIRectory <string>
Description Creates a new directory (no query).
Parameter <string> Directory full name (quoted string)
Equivalent
Softkeys None
MMEM:STOR

MMEMory:STORe [ :STATe] <string>

Description Saves the instrument state into a file (no query).
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \State subdirectory of
Notes the main directory will be searched for the file. The state file has
*.sta extension by default.
Equivalent
> >
Softkeys System > Save > State
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MMEM:STOR:CHAN

MMEMory: STORe:CHANnel [ : STATe] <char>

Saves the instrument state of the items set for the active channel

Description into one of the four memory registers (no query).
Target Active channel set by the DISP:WIND:ACT command
<char> choose from:
A : Save to register A
Parameter B : Save to register B
C : Save to register C
D : Save to register D
Out of Range The command is ignored.
gz;g:;jm System > Save/Recall > Channel > { State A|B|C|D}

MMEM:STOR:CHAN:CLE

MMEMory:STORe:CHANnel : CLEar

. Clears the memory of the channel state saved by the
Description
MMEM : STOR : CHAN command (no query).
Equivalent
> > >
Softkeys System > Save/Recall > Channel > Clear States
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MMEM:STOR:CKIT

MMEMory: STORe:CKIT<Ck> <string>

Description Saves the definition file for the calibration kit (no query).
Taraet Calibration kit <Ck>,
g <Ck>={[1]1213141516171819110111}

Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \CalKit subdirectory of

Notes the main directory will be searched for the file. The calibration kit
definition file has *.ckd extension by default.

Equivalent

Softkeys None

MMEM:STOR:FDAT

MMEMory:STORe:FDATa <string>

Description Saves the CSV formatted data into a file (no query).
Active trace of the active channel, set by the CALC: PAR: SEL
Target
command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \CSV subdirectory of
Notes the main directory will be searched for the file. The file has *.csv
extension by default.
Equivalent System > Save > Save Trace Data
Softkeys y
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MMEM:STOR:IMAG

MMEMory: STORe: IMAGe <string>

Description Saves the display image in BMP or PNG format into a file (no query).
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Image subdirectory of
Notes the main directory will be searched for the file. If the file has *.png
extension, the file had PNG format, in all the other cases the file has
BMP format.
Equivalent . . .
System > Print > Print Windows > Save as...
Softkeys

MMEM:STOR:LIM

MMEMory:STORe:LIMit <string>

Description Saves the limit table into a file (no query).
Active trace of the active channel, set by the CALC: PAR: SEL
Target
command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Limit subdirectory of
Notes the main directory will be searched for the file. The file has *.lim
extension by default.
Equivalent Analysis > Limit Test > Edit Limit Line > Save Limit Table
Softkeys
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MMEM:STOR:RLIM

MMEMory:STORe:RLIMit <string>

Description Saves the ripple limit table into a file (no query).
Active trace of the active channel, set by the CALC: PAR: SEL
Target
command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Limit subdirectory of
Notes the main directory will be searched for the file. The ripple limit file
has *.rlm extension by default.
Equivalent . . . . . . .
Softkeys Analysis > Ripple Limit > Edit Ripple Limit > Save Ripple Limit Table

MMEM:STOR:SEGM

MMEMory:STORe: SEGMent <string>

Description Save the segment table in a file (no query).

Target Active channel, set by the DISP:WIND:ACT command

Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Segment subdirectory

Notes of the main directory will be searched for the file. The segment file
has *.seg extension by default.

Equivalent Stimulus > Segment Table > Save

Softkeys g
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MMEM:STOR:SNP

MMEMory:STORe:SNP[:DATA] <string>

Saves the measured S-parameters of the active channel into a
Touchstone file. The file type (1-port or 2-port) is set by the
MMEM: STOR: SNP: TYPE:S1P and MMEM: STOR: SNP: TYPE:S2P
commands. 1-port type file saves one reflection parameter: S11 or

Description $22. 2-port type file saves all the four parameters: S11, $21, 12,
S22.
(no query)
Target Active channel, set by the DISP:WIND:ACT command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \FixtureSim
subdirectory of the main directory will be searched for the file. The
Notes . . .
1-port measurement file has *.slp extension; the 2-port
measurement file has *.s2p extension.
Equivalent System > Save > Touchstone File > Save
Softkeys Y
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MMEM:STOR:SNP:FORM

MMEMory:STORe:

MMEMory:STORe:

SNP:FORMat <char>

SNP:FORMat?

Descrintion Sets the data format for the S—parameter saving by the
p MMEM:STOR:SNP command (command/query).
Target Active channel, set by the DISP:WIND:ACT command
<char> choose from:
MA : Logarithmic Magnitude / Angle format
Parameter
DB : Linear Magnitude / Angle format
RI : Real part /Imaginary part format
Out of Range The command is ignored.
Query Response | {RI|DB|MA}
Preset Value RI
Equivalent .
System > Save > Touchstone File > Format
Softkeys

MMEM:STOR:SNP:TYPE:S1P

MMEMory:STORe:

MMEMory:STORe:

SNP: TYPE:S1P <port>

SNP:TYPE:S1P?

Sets the 1-port Touchstone file type (*.s1p) and the port number,

Description when saving S—parameters by the MMEM: STOR : SNP command.
(command/query)

Parameter <port> port number from 1 to 2

Query Response <numeric>

Preset Value 1

Equivalent Softkeys

System > Save > Touchstone File > Type > 1-Port (s1p)
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MMEM:STOR:SNP:TYPE:S2P

MMEMory:STORe:SNP:TYPE:S2P <rcvport>, <srcport>

MMEMory:STORe: SNP:TYPE:S2P?

Sets the 2-port Touchstone file type (*.s2p) and the port numbers,
Description when saving S—parameters by the MMEM: STOR : SNP command.
(command/query)

<rcvport> the number of the receiver port from 1 to 2
Parameter

<srcport> the number of the source port 1

Query Response <numericl>, <numeric2>

Equivalent Softkeys | System > Save > Touchstone File > Type > 2-Port (s2p)
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MMEM:STOR:STYP

MMEMory:STORe:STYPe <char>

MMEMory:STORe:STYPe?

Selects the type of the instrument or channel state saving by the

Description
MMEM: STOR : CHAN command (command/query).
<char> choose from:
STATe : Measurement conditions
CSTate : Measurement conditions and calibration tables
Parameter
DSTate : Measurement conditions and data traces
CDSTate : Measurement conditions, calibration tables and
data traces
Out of Range An error occurs.
Query Response | {STAT|CST |DST|CDST}

Preset Value

CST

Equivalent
Softkeys

System > Save > Save Type
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MMEM:TRAN?

MMEMory:TRANsfer? <string>

Transfers the contents of a specified file from the instrument to the

Description external computer (command/query).
Parameter <string> the file name with the full path (quoted string)
Block data transfer format. For example:
#6001000 <binary block with length of 1000 bytes>
Query Response | #6 Symbol # introduces the data block. The next
number indicates how many of the following digits
describe the length of the data block;
001000 Length of the data block;
Notes The file must be 20 Mbytes or less.
T e
OUTP

OUTPut [:STATe]

{ON|OFF|1]|0}

OUTPut [:STATe]?

Sets or reads out the ON/OFF state of the stimulus signal output.

Description Measurements cannot be performed when the stimulus signal
output is set to OFF (command/query).
{ON|1}  Stimulus signal output ON

Parameter
{OFF |0} Stimulus signal output OFF

Query Response | {01}

Preset Value 1

Equivalent
Softkeys

Stimulus > Power > RF Out Off
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SENS:AVER

SENSe<Ch>:AVERage[:STATe] {ON|OFF|1]|0}

SENSe<Ch>:AVERage [ :STATe]?

Sets or reads out the ON/OFF state of the averaging function

Description (command/query).
Taraet Channel <Ch>,
g <Ch>={[1]12131415161718]9}

{ON|1}  Averaging ON

Parameter
{OFF 10} Averaging OFF

Query Response | {01}

Preset Value 0

Equival .
SZ;ItI/:/:yfnt Response > Averaging
SENS:AVER:CLE

SENSe<Ch>:AVERage:CLEar

Restarts the averaging process, when averaging function is set to

Description ON (no query).
Taraet Channel <Ch>,
g <Ch>={[1]12131415161718]9}
Related SENS :AVER
Commands
Equivalent
Softkeys None
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SENS:AVER:COUN

SENSe<Ch>:AVERage :COUNt <numeric>

SENSe<Ch>:AVERage : COUNt?

Sets or reads out the averaging factor, when the averaging function

Description is set to ON (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]161718]9}
Parameter <numeric> the averaging factor from 1 to 999
Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value 10

Related SENS : AVER
Commands

Equivalent

Softkeys Response > Avg Factor
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SENS:BAND

SENSe<Ch>:BANDwidth[:RESolution] <frequency>

SENSe<Ch>:BANDwidth[:RESolution]?

SENS:BWID

SENSe<Ch>:BWIDth[:RESolution] <frequency>

SENSe<Ch>:BWIDth[:RESolution]?

Description Sets or reads out the IF bandwidth (command/query).
Target Chann_el <Ch>,
<Ch>={[1]112131415]161718]9}
Parameter <frequency> the IF bandwidth value from 1 to 30000
Unit Hz (Hertz)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 10000

Resolution In steps of 10, 30, 100, 300, 1000, 3000, 10000, 30000
Equivalent .

>
Softkeys Response > IF Bandwidth
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SENS:CORR:CLE

SENSe<Ch>:CORRection:CLEar

Description Clears the calibration coefficient table (no query).
Taraet Channel <Ch>,
g <Ch>={[1]121314151617181]9}
Equivalent
Softkeys None
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SENS:CORR:COEF

SENSe<Ch>:CORRection:COEFficient[:DATA]? <char>,
<rcvport>,<srcport>,<numeric list>

SENSe<Ch>:CORRection:COEFficient [ :DATA]? <char>,
<rcvport>,<srcport>

Description

Writes or reads out the calibration coefficient data array
(command/query).

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

<numeric 2Zn-1> real part of the calibration coefficients

<numeric 2n> imaginary part of the calibration
coefficients

Target

Channel <Ch>,
<Ch>={[1]121314|5]6]1718]9}

Parameter

<char> specifies the error term selection:

ER : Reflection tracking

ED : Directivity

ES : Source match

ET : Transmission tracking

EX :Isolation

EL : Load match

<rcvport>, the number of the receiver port from 1 to 2
<srcport> the number of the source port =1
<numeric list> the calibration coefficient array

When ES, ER, or ED is used, the numbers of the ports <rcvport>
and <srcport> must be the same. When EL, ET, or EX is used, the
numbers of the ports <rcvport> and <srcport> must be
different.

Query Response

<numeric 1>, <numeric 2>, .<numeric 2N>

Notes

The written calibration coefficients become effective only after the
SENS:CORR:COEF:SAVE command is executed.

Equivalent
Softkeys

None
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SENS:CORR:COEF:METH:ERES

SENSe<Ch>:CORRection:COEFficient :METHod:ERESponse
<rcvport>,<srcport>

Selects the ports and sets the 1-path 2-port calibration type, when
Description the written calibration coefficients are made effective by the
SENS:CORR:COEF: SAVE command (no query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<rcvport>, the number of the receiver port from 1 to 2
Parameter
<srcport>, the number of the source port =1
If an incorrect port number is specified, an error occurs. If the same
Out of Range -
port numbers are specified, an error occurs.
Related SENS:CORR:COEF: SAVE
Commands
Equivalent
q None
Softkeys
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SENS:CORR:COEF:METH:OPEN

SENSe<Ch>:CORRection:COEFficient :METHod[:RESPonse] :OPEN <port>

Selects the port and sets the response calibration (Open) type, when

Description the written calibration coefficients are made effective by the
SENS:CORR:COEF: SAVE command (no query).

Taraet Channel <Ch>,

9 <Ch>={[1]12131415/61718]9}

Parameter <port> the number of the port from 1 to 2

Out of Range An error occurs..

Related SENS:CORR:COEF: SAVE

Commands

Equivalent

9 None
Softkeys
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SENS:CORR:COEF:METH:SHOR

SENSe<Ch>:CORRection:COEFficient :METHod|[ :RESPonse] : SHORt
<port>

Selects the port and sets the response calibration (Short) type, when

Description the written calibration coefficients are made effective by the
SENS:CORR:COEF: SAVE command (no query).

Taraet Channel <Ch>,

g <Ch>={[1]112131415/61718]9}

Parameter <port> the number of the port from 1 to 2

Out of Range An error occurs.

Related SENS : CORR : COEF : SAVE

Commands

Equivalent

9 None
Softkeys
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SENS:CORR:COEF:METH:SOLT1

SENSe<Ch>:CORRection:COEFficient:METHod:SOLT1 <port>

Selects the port and sets the full 1-port calibration type, when the

Description written calibration coefficients are made effective by the
SENS:CORR:COEF: SAVE command (no query).

Taraet Channel <Ch>,

9 <Ch>={[1]12131415/61718]9}

Parameter <port> the number of the port from 1 to 2

Out of Range An error occurs.

Related SENS:CORR:COEF: SAVE

Commands

Equivalent

quiv None
Softkeys
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SENS:CORR:COEF:METH:THRU

SENSe<Ch>:CORRection:COEFficient :METHod|[ :RESPonse] : THRU
<rcvport>, <srcport>

Selects the ports and sets the response calibration (Thru) type, when
Description the written calibration coefficients are made effective by the
SENS:CORR:COEF: SAVE command (no query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
<rcvport>, the number of the receiver port from 1 to 2
Parameter
<srcport>, the number of the source port =1
If an incorrect port number is specified, an error occurs. If the same
Out of Range .
port numbers are specified, an error occurs.
Related SENS:CORR:COEF: SAVE
Commands
Equivalent
q None
Softkeys
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SENS:CORR:COEF:SAVE

Remote Control Commands

SENSe<Ch>:CORRection:COEFficient:SAVE

Description

Enables the written calibration coefficients depending on the
selected calibration type.
On completion of the command the error correction automatically
turns ON.

At the attempt to execute this command before all the needed
calibration coefficients are written, an error occurs and the
command is ignored (no query).

Target

Channel <Ch>,
<Ch>={[1]121314|5]6]1718]9}

Related
Commands

Calibration type selection:

SENS:
SENS:

SENS

SENS:
SENS:

CORR:
CORR:
:CORR:
CORR:
CORR:

COEF':
COEF':
COEF':
COEF':
COEF':

METH:
METH:

METH

ERES
OPEN

: SHOR
METH:
METH:

THRU
SOLT1

Calibration coefficient writing:
SENS:CORR:COEF

Equivalent
Softkeys

None
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SENS:CORR:COLL:CKIT

SENSe<Ch>:CORRection:COLLect:CKIT[:SELect] <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT[:SELect]?

e Sets or reads out the number of the selected calibration kit
Description

(command/query).
Target Channel <Ch>,

<Ch>={[1]112131415]61718]9}
Parameter <numeric> the number of the calibration kit from 1 to 11
Out of Range Error occurs. The command is ignored..

Query Response | <numeric>

Preset Value 1

Equivalent

ot s .
Softkeys Calibration > Cal Kit > Cal Kit n
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SENS:CORR:COLL:CKIT:LAB

SENSe<Ch>:CORRection:COLLect:CKIT:LABel <string>

SENSe<Ch>:CORRection:COLLect:CKIT:LABel?

Description Sets or reads out the calibration kit label (command/query).

Calibration kit, selected for channel <Ch>,

Target <Ch>={[1]1213141516171819}

Parameter <string>, up to 254 characters (quoted string)

Query Response | <string>

Preset Value Varies depending on the number of the calibration kit.

Equivalent

b B .
Softkeys Calibration > Edit Cal Kit > Label
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SENS:CORR:COLL:CKIT:RES

SENSe<Ch>:CORRection:COLLect:CKIT:RESet

Description Resets the calibration kit to the factory settings (no query).
Taraet Calibration kit, selected for channel <Ch>,
g <Ch>={[1]121314151617181]9}
Equivalent Calibration > Restore Cal Kit
Softkeys

SENS:CORR:COLL:CKIT:STAN:CO

SENSe<Ch>:CORRection:COLLect:CKIT:STANKStd>:C0O0 <numeric>

SENSe<Ch>:CORRection:COLLect :CKIT:STANKStd>:CO?

Sets or reads out the CO value for the open calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,

T ; <Ch>={[1112131415|6]718]9}

arge <Std>={[1112]|...N}, where N - the number of the standards

in the calibration kit

Parameter <numeric> the CO value from -1E18 to 1E18

Unit 1E-15 F (Farad)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Equivalent Calibration > Edit Cal Kit > Capacitance > CO 10-%5 F

Softkeys
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SENS:CORR:COLL:CKIT:STAN:C1

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:Cl <numeric>

SENSe<Ch>:CORRection:COLLect :CKIT:STAN<KStd>:C1?

Sets or reads out the C1 value for the open calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,

5 ; <Ch>={[1]121314|5]6]1718]9}

arge <Std>={[1]112]|...N}, where N - the number of the standards

in the calibration kit

Parameter <numeric> the C1 value from -1E18 to 1E18

Unit 1E-27 F/Hz (Farad/Hertz)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Equivalent Calibration > Edit Cal Kit > Capacitance > C1 10-?” F/Hz

Softkeys
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SENS:CORR:COLL:CKIT:STAN:C2

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:C2 <numeric>

SENSe<Ch>:CORRection:COLLect :CKIT:STAN<KStd>:C27?

Sets or reads out the C2 value for the open calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
5 ; <Ch>={[1]121314|5]6]1718]9}
arge <Std>={[1]112]|...N}, where N - the number of the standards
in the calibration kit
Parameter <numeric> the C2 value from -1E18 to 1E18
Unit 1E-36 F/Hz2 (Farad/Hertz2)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Equivalent Calibration > Edit Cal Kit > Capacitance > C2 1073¢ F/Hz?
Softkeys
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SENS:CORR:COLL:CKIT:STAN:C3

SENSe<Ch>:CORRection:COLLect:CKIT:STANKStd>:C3 <numeric>

SENSe<Ch>:CORRection:COLLect :CKIT:STANKStd>:C3?

Sets or reads out the C3 value for the open calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
5 ; <Ch>={[1]121314|5]6]1718]9}
arge <Std>={[1]112]|...N}, where N - the number of the standards
in the calibration kit
Parameter <numeric> the C3 value from -1E18 to 1E18
Unit 1E-45 F/Hz3 (Farad/Hertz3)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Equivalent Calibration > Edit Cal Kit > Capacitance > C3 10-*° F/HZ?
Softkeys
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SENS:CORR:COLL:CKIT:STAN:DEL

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:DELay <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:Delay?

Sets or reads out the offset delay value for the calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
5 ; <Ch>={[1]12131415161718]9}
arge <Std>={[1]112]|...N}, where N - the number of the standards
in the calibration kit
Parameter <numeric> the offset delay value form —-1E18 to 1E18
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Equivalent o . .
Calibration > Edit Cal Kit > Offset Delay
Softkeys
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SENS:CORR:COLL:CKIT:STAN:LO

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:L0 <numeric>

SENSe<Ch>:CORRection:COLLect :CKIT:STAN<KStd>:L0?

Sets or reads out the LO value for the short calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,

5 ; <Ch>={[1]121314|5]6]1718]9}

arge <Std>={[1]112]|...N}, where N - the number of the standards

in the calibration kit

Parameter <numeric> the LO value from -1E18 to 1E18

Unit 1E-12 H (Henry)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Equivalent Calibration > Edit Cal Kit > Inductance > L0 10~ H

Softkeys
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SENS:CORR:COLL:CKIT:STAN:L1

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:L1l <numeric>

SENSe<Ch>:CORRection:COLLect :CKIT:STAN<KStd>:L17?

Sets or reads out the L1 value for the short calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,

5 ; <Ch>={[1]121314|5]6]1718]9}

arge <Std>={[1]112]|...N}, where N - the number of the standards

in the calibration kit

Parameter <numeric> the L1 value from -1E18 to 1E18

Unit 1E-24 H/Hz (Henry/Hertz)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Equivalent Calibration > Edit Cal Kit > Inductance > L1 10-2* H/Hz

Softkeys
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SENS:CORR:COLL:CKIT:STAN:L2

SENSe<Ch>:CORRection:COLLect:CKIT:STANKStd>:L2 <numeric>

SENSe<Ch>:CORRection:COLLect :CKIT:STAN<KStd>:L27

Sets or reads out the L2 value for the short calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,

5 ; <Ch>={[1]121314|5]6]1718]9}

arge <Std>={[1]112]|...N}, where N - the number of the standards

in the calibration kit

Parameter <numeric> the L2 value from -1E18 to 1E18

Unit 1E-33 H/Hz2 (Henry/Hertz2)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Equivalent Calibration > Edit Cal Kit > Inductance > L2 10733 H/HZ2

Softkeys
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SENS:CORR:COLL:CKIT:STAN:L3

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:L3 <numeric>

SENSe<Ch>:CORRection:COLLect :CKIT:STAN<KStd>:L3?

Sets or reads out the L3 value for the short calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,

5 ; <Ch>={[1]121314|5]6]1718]9}

arge <Std>={[1]112]|...N}, where N - the number of the standards

in the calibration kit

Parameter <numeric> the L3 value from -1E18 to 1E18

Unit 1E-42 H/Hz3 (Henry/Hertz3)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Equivalent Calibration > Edit Cal Kit > Inductance > L3 10-*> H/HZ?

Softkeys

184




Remote Control Commands

SENS:CORR:COLL:CKIT:STAN:LAB

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:LABel <string>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:LABel?

Sets or reads out the label for the calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
5 ; <Ch>={[1]121314|5]6]1718]9}
arge <Std>={[1]112]|...N}, where N - the number of the standards
in the calibration kit
Parameter <string>, up to 254 characters (quoted string)

Query Response | <string>

Equivalent

Softkeys Calibration > Edit Cal Kit > Label
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SENS:CORR:COLL:CKIT:STAN:LOSS

SENSe<Ch>:CORRection:COLLect:CKIT:STANKStd>:LOSS <loss>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:LOSS?

Sets or reads out the offset loss value for the calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
5 ; <Ch>={[1]121314|5]6]1718]9}
arge <Std>={[1]112]|...N}, where N - the number of the standards
in the calibration kit
Parameter <loss> the offset loss value from -1E18 to 1E18
Unit Q/s (Ohm/second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Equivalent o . .
Calibration > Edit Cal Kit > Offset Loss
Softkeys
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SENS:CORR:COLL:CKIT:STAN:TYPE

SENSe<Ch>:CORRection:COLLect:CKIT:STANKStd>:TYPE <char>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:TYPE?

Description Sets or reads out the type of calibration standard (command/query).

Standard <Std> of the calibration kit specified for channel <Ch>,
<Ch>={[1]12131415]161718]9}

<Std>={[1112]|...N}, where N - the number of the standards
in the calibration kit

Target

<char> choose from:
OPEN : Open
Parameter SHORt : Short
LOAD : Load

THRU : Thru

Out of Range Error occurs. The command is ignored..

Query Response | {OPEN | SHOR|LOAD | THRU}

Equivalent

Softkeys Calibration > Edit Cal Kit > STD Type
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SENS:CORR:COLL:CKIT:STAN:Z0

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<KStd>:Z0 <impedance>

SENSe<Ch>:CORRection:COLLect :CKIT:STAN<KStd>:Z0?

Sets or reads out the offset Z0 value for the calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,

5 ; <Ch>={[1112131415|6]718]9}

arge <Std>={[1]112]|...N}, where N - the number of the standards

in the calibration kit

Parameter <impedance> the offset Z0 value from -1E18 to 1E18

Unit Q (Ohm)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value

50 or 75, depending on the selected calibration kit

Equivalent Calibration > Edit Cal Kit > Offset Z0
Softkeys
SENS:CORR:COLL:CLE

SENSe<Ch>:CORRection:COLLect:CLEar

Clears the measurement values of the calibration standards (no

Description query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/61718]9}
Equivalent Calibration > Calibrate > { Response (Open) | Response (Short) |
Softkeys Response (Thru) | One Path 2-Port Cal | Full 1-Port Cal } > Cancel
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SENS:CORR:COLL:ECAL:CHECK:EXEC

SENSe<Ch>:CORRection:COLLect:ECAL:CHECK:EXECute <numericl>,

<numeric?2>
Description Executing confidence check
Taraet AutoCal module
g (Ch - arbitrary number 1 to 9)
Equivalent Calibration > Autocalibration > Confidence Check
Softkeys

SENS:CORR:COLL:ECAL:ORI:EEXEC

SENSe<Ch>:CORRection:COLLect:ECAL:ORIentation:EXECute

<numericl>, <numeric2>
Description Executing AutoCal orientation to the ports Rcv, Scr
Target AutoCal module
Equivalent . . . .
Calibration > Autocalibration > Perform Auto-Orientation
Softkeys
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SENS:CORR:COLL:ECAL:ORI:STAT

SENSe:CORRection:COLLect:ECAL:ORIentation:STATe {ON|OFF|1|0}

SENSe:CORRection:COLLect:ECAL:ORIentation:STATe?

Sets or reads out the ON/OFF state of the Auto-Orientation function

Description used when executing AutoCal (command/query).
Target AutoCal

{ON]1} Auto-Orientation function ON
Parameter

{OFF |0} Auto-Orientation function OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Calibration > AutoCal > Orientation > Auto-Orientation
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SENS:CORR:COLL:ECAL:PATH

SENSe:CORRection:COLLect:ECAL:PATH <numericl>,<numeric2>

SENSe:CORRection:COLLect:ECAL:PATH? <numericl>

Sets or reads out the AutoCal module port number which is

Description connected to a specified port of Network Analyzer
(command/query).
Target AutoCal
<numericl> Network Analyzer Port Number,
<numeric2> AutoCal Module Port Number,
1 : Port A of AutoCal Module
Parameter
2 : Port B of AutoCal Module
3 : Port C of AutoCal Module
4 : Port D of AutoCal Module
Query Response | <numeric>
Equivalent Calibration > AutoCal > Orientation > Port 1 - Port A | Port 1 - Port
Softkeys B|Portl - PortC|Port1 - PortD
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SENS:CORR:COLL:ECAL:SOLT1

SENSe<Ch>:CORRection:COLLect:ECAL:SOLT1 <port>

Executes Full 1-port calibration of the specified port of specified

Description channel (Ch) using the AutoCal module (command only).
Taraet Channel <Ch>,
g <Ch>={[1]121314151617189}
Parameter <port> :Port Number 1
Equivalent Calibration > AutoCal > Full 1-Port Calibration
Softkeys

SENS:CORR:COLL:ECAL:SOLT2

SENSe<Ch>:CORRection:COLLect:ECAL:SOLT1 <port2>,<portl>

Executes One Path 2-Port calibration of the specified port of

Description specified channel (Ch) using the AutoCal module (command only).
Taraet Channel <Ch>,
9 <Ch>={[1]1213141516171819}
<portl>  the number of the receiver port (always 1)
Parameter
<port2>  the number of the source port (always 2)
Equivalent Calibration > AutoCal > One Path 2-Port Calibration
Softkeys
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SENS:CORR:COLL:ECAL:UCH

SENSe:CORRection:COLLect:ECAL:UCHar <char>

SENSe:CORRection:COLLect:ECAL:UCHar?

Sets or reads out the Characteristic used when executing AutoCal

Description (factory or user characterization). (command/query).
Target AutoCal
<char> specifies the stimulus type:
CHARO : factory characterization
Parameter CHAR1 : user characterization 1
CHAR2 : user characterization 2
CHAR3 : user characterization 3
Query Response | {CHARO | CHARI | CHARZ2 | CHAR3}

Preset Value

CHARO

Equivalent
Softkeys

Calibration > AutoCal > Characterization
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SENS:CORR:COLL:LOAD

SENSe<Ch>:CORRection:COLLect[:ACQuire] :LOAD <port>

Measures the calibration data of the load standard for the specified

Description port (no query).
Taraet Channel <Ch>,
g <Ch>={[1]12131415161718]9}
Parameter <port> the number of the port from 1 to 2
Out of Range Error occurs. The command is ignored.
The command start the measurement for the channel independently
Notes of the trigger and trigger source settings. The command waits for
the completion of the measurement.
Calibration > Calibrate > Response (Open) > Load (Optional)
ibration > Cali > > i
Equivalent Calibration > Calibrate > Response (Short) > Load (Optional)
Softkeys

Calibration > Calibrate > Full 1-Port Cal > Load

Calibration > Calibrate > One Path 2-Port Cal > Load
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SENS:CORR:COLL:METH:ERES

SENSe<Ch>:CORRection:COLLect :METHod:ERESponse <rcvport>,

<srcport>
Selects the ports and sets the one path 2-port calibration type for
. the calculation of the calibration coefficients on completion of the
Description i i
calibration executed by the SENS : CORR:COLL: SAVE command
(no query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/6]718]9}
<rcvport>, the number of the receiver port from 1 to 2
Parameter
<srcport>, the number of the source port =1
If an incorrect port number is specified, an error occurs. If the same
Out of Range port numbers are specified, an error occurs. The command is
ignored.
Related SENS : CORR: COLL: SAVE
Commands
Equivalent
q None
Softkeys
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Remote Control Commands

SENS:CORR:COLL:METH:OPEN

SENSe<Ch>:CORRection:COLLect:METHod [ :RESPonse] :OPEN <port>

Selects the port and sets the response calibration (Open) type for
. the calculation of the calibration coefficients on completion of the

Description . .
calibration executed by the SENS: CORR: COLL: SAVE command
(no query).

Taraet Channel <Ch>,

9 <Ch>={[1]112131415/6]718]9}

Parameter <port> the number of the port from 1 to 2

Out of Range Error occurs. The command is ignored.

Related SENS:CORR:COLL: SAVE

Commands

Equivalent

Softkeys None
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SENS:CORR:COLL:METH: SHOR

SENSe<Ch>:CORRection:COLLect:METHod [ :RESPonse] : SHORt <port>

Selects the port and sets the response calibration (Short) type for
. the calculation of the calibration coefficients on completion of the

Description . .
calibration executed by the SENS: CORR: COLL: SAVE command
(no query).

Taraet Channel <Ch>,

9 <Ch>={[1]112131415/6]718]9}

Parameter <port> the number of the port from 1 to 2

Out of Range Error occurs. The command is ignored.

Related SENS:CORR:COLL: SAVE

Commands

Equivalent

Softkeys None
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SENS:CORR:COLL:METH:SOLT1

SENSe<Ch>:CORRection:COLLect :METHod:SOLT1 <port>

Selects the port and sets the full 1-port calibration type for the
. calculation of the calibration coefficients on completion of the

Description . .
calibration executed by the SENS: CORR: COLL: SAVE command
(no query).

Taraet Channel <Ch>,

9 <Ch>={[1]112131415/6]718]9}

Parameter <port> the number of the port from 1 to 2

Out of Range Error occurs. The command is ignored.

Related SENS:CORR:COLL: SAVE

Commands

Equivalent

Softkeys None
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Remote Control Commands

SENS:CORR:COLL:METH:THRU
SENSe<Ch>:CORRection:COLLect:METHod[:RESPonse] : THRU <rcvport>,
<srcport>

Selects the ports and sets the response calibration (Thru) type for

. the calculation of the calibration coefficients on completion of the

Description i i
calibration executed by the SENS : CORR:COLL: SAVE command
(no query).

Taraet Channel <Ch>,

9 <Ch>={[1]112131415/6]718]9}

<rcvport>, the number of the receiver port from 1 to 2

Parameter
<srcport>, the number of the source port =1
If an incorrect port number is specified, an error occurs. If the same

Out of Range port numbers are specified, an error occurs. The command is
ignored.

Related SENS : CORR: COLL: SAVE

Commands

Equivalent

q None
Softkeys
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SENS:CORR:COLL:METH:TYPE?

SENSe<Ch>:CORRection:COLLect :METHod:TYPE?

Reads out the calibration type selected for the calculation of the

Description calibration coefficients on completion of the calibration executed by
the SENS:CORR:COLL: SAVE command (query only).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/6]718]9}
RESPO" : Response (Open)
RESPS : Response (Short)
RESPT : Response (Thru)
Query Response
SOLT1 : Full 1-port calibration
1PATH : One path 2-port calibration
NONE : Not defined
Equivalent
Softkeys None
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SENS:CORR:COLL:OPEN

SENSe<Ch>:CORRection:COLLect[:ACQuire] :OPEN <port>

Measures the calibration data of the open standard for the specified

Description port (no query).
Taraet Channel <Ch>,
g <Ch>={[1]12131415161718]9}

Parameter <port> the number of the port from 1 to 2

Out of Range Error occurs. The command is ignored.
The command start the measurement for the channel independently

Notes of the trigger and trigger source settings. The command waits for
the completion of the measurement.
Calibration > Calibrate > Response (Open) > Open

Equivalent Calibration > Calibrate > Full 1-Port Cal > Open

Softkeys

Calibration > Calibrate > One Path 2-Port Cal > Open
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SENS:CORR:COLL:SAVE

SENSe<Ch>:CORRection:COLLect: SAVE

Description

Calculates the calibration coefficients from the calibration standards
measurements depending on the selected calibration type.

On completion of the command, all the calibration standards
measurements are cleared and the error correction automatically
turns ON.

Before executing this command it is neccessery to select calibration
type by one of commands SENS : CORR: COLL :METH : XXXX.

At the attempt to execute this command before all the needed
standards are measured, an error occurs and the command is
ignored (no query).

Target

Channel <Ch>,
<Ch>={[1]121314|5]6]1718]9}

Related
Commands

Calibration type selection:
SENS:CORR:COLL:METH: OPEN
SENS:CORR:COLL:METH: SHOR
SENS:CORR:COLL:METH: THRU
SENS:CORR:COLL:METH:ERES
SENS:CORR:COLL:METH:SOLT1

Calibration standards measurement:
SENS :CORR:COLL:LOAD
SENS :CORR:COLL:0OPEN
SENS :CORR:COLL:SHOR
SENS :CORR:COLL: THRU

Equivalent
Softkeys

Calibration > Calibrate > { Response (Open) | Response (Short) |
Response (Thru) | One Path 2-Port Cal | Full 1-Port Cal } > Apply
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SENS:CORR:COLL:SHOR

SENSe<Ch>:CORRection:COLLect[:ACQuire] : SHORt <port>

Measures the calibration data of the short standard for the specified

Description port (no query).
Taraet Channel <Ch>,
g <Ch>={[1]12131415161718]9}

Parameter <port> the number of the port from 1 to 2

Out of Range Error occurs. The command is ignored.
The command start the measurement for the channel independently

Notes of the trigger and trigger source settings. The command waits for
the completion of the measurement.
Calibration > Calibrate > Response (Short) > Short

Equivalent Calibration > Calibrate > Full 1-Port Cal > Short

Softkeys

Calibration > Calibrate > One Path 2-Port Cal > Short
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SENS:CORR:COLL:THRU
SENSe<Ch>:CORRection:COLLect[:ACQuire] : THRU <rcvport>,
<srcport>

Measures the calibration data of the thru standard between the
Description receiver port <rcvport> and the source port <srcport> (no
query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/6]718]9}
<rcvport>, the number of the receiver port from 1 to 2
Parameter
<srcport>, the number of the source port =1
If an incorrect port number is specified, an error occurs. If the same
Out of Range port numbers are specified, an error occurs. The command is
ignored.
The command start the measurement for the channel independently
Notes of the trigger and trigger source settings. The command waits for
the completion of the measurement.
. Calibration > Calibrate > Response (Thru) > Thru
Equivalent
Softkeys

Calibration > Calibrate > One Path 2-Port Cal > Thru
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SENS:CORR:EXT

SENSe<Ch>:CORRection:EXTension[:STATe] {ON|OFF|1|0}

SENSe<Ch>:CORRection:EXTension|[:STATe]?

Sets or reads out the ON/OFF state of the port extension function

Description (command/query).
Taraet Channel <Ch>,
9 <Ch>={[11121314|5]6]17|8]9}
{ON]1} Port extension function ON
Parameter
{OFF |0} Port extension function OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Calibration > Port Extensions > Extension
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SENS:CORR:EXT:PORT:FREQ

SENSe<Ch>:CORRection:EXTension: PORT<Pt>:FREQuency{[1] |2}

<frequency>

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:FREQuency{[1]]|2}?

Sets or reads out the values of the frequency 1 and frequency 2 to

Description calculate the loss for the port extension function (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]12131415161718]9}
<Pt>={[1]|2}
<frequency> the frequency value
Parameter from 3E5 to 1.3E9 (Planar - TR1300/1),
from 2E4 to 4.8E9 (TR5048),
from 2E4 to 3.0E9 (TR7530)
Unit Hz (Hertz)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 1E9

Equivalent
Softkeys

Calibration > Port Extensions > Loss > { Freql | Freq2 }
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SENS:CORR:EXT:PORT:INCL

SENSe<Ch>:CORRection:EXTension: PORT<Pt>:INCLude{[1] |2} [:STATe]
{ON|OFF |10}

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:INCLude{[1] |2}
[:STATe]?

Sets or reads out the ON/OFF state of the compensation of the loss

Description 1 and loss 2 for the port extension function (command/query).
Taraet Channel <Ch>,
9 <Ch>={[1]1213141516171819}
{ON|1}  Loss compensation ON
Parameter

{OFF|0} Loss compensation OFF

Query Response | {01}

Preset Value 0
Equivalent Calibration > Port Extensions > Loss > { Loss1 | Loss2 }
Softkeys
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SENS:CORR:EXT:PORT:LDC

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:LDC <loss>

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:LDC?

Sets or reads out the loss value at DC for the port extension

Description function (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]112131415]61718]9}
<Pt>={[1]12}
Parameter <loss> the loss value from -200 to 200
Unit dB (decibel)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Calibration > Port Extensions > Loss > Loss at DC
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SENS:CORR:EXT:PORT:LOSS

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:L0SS{[1] ]2} <loss>

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:L0OSS{[1]]2}?

Sets or reads out the values of the loss 1 and loss 2 for the port

Description extension function (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]112131415]61718]9}
<Pt>={[1]12}
Parameter <loss> the loss value from -200 to 200
Unit dB (decibel)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Calibration > Port Extensions > Loss > { Loss1 | Loss2 }
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SENS:CORR:EXT:PORT:TIME

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:TIME <time>

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:TIME?

Sets or reads out the electrical delay value for the port extension

Description function (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]112131415]61718]9}
<Pt>={[1]12}
Parameter <time> the electrical delay value from -10 to 10
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Calibration > Port Extensions > { Extension Port1 | Extension Port2 }
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SENS:CORR:IMP

SENSe:CORRection:IMPedance [ :INPut] [ :MAGNitude] <impedance>

SENSe:CORRection:IMPedance [ :INPut] [ :MAGNitude]?

Description Sets or reads out the system impedance Z0 (command/query)
Parameter <impedance> the Z0 value from 0.001 to 1000

Unit Q (Ohm)

Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value 50

Equivalent

Softkeys Calibration > System Z0
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Remote Control Commands

SENS:CORR:STAT

SENSe<Ch>:CORRection:STATe {ON|OFF|1]|0}

SENSe<Ch>:CORRection:STATe?

Sets or reads out the ON/OFF state of the error correction

Description (command/query).
Taraet Channel <Ch>,
9 <Ch>={[11121314|5]6]17|8]9}
{ON]1} Error correction ON
Parameter
{OFF |0} Error correction OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Calibration > Correction
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Remote Control Commands

SENS:CORR:TRAN:TIME:FREQ

SENSe<Ch>:CORRection:TRANsform: TIME: FREQuency <frequency>

SENSe<Ch>:CORRection:TRANsform: TIME : FREQuency?

Sets or reads out the frequency value at which the cable loss
specified for the cable correction function, when the time domain

Description . N
p transformation function is turned ON.
(command/query)
Taraet Channel <Ch>,

g <Ch>={[1]112131415]161718]9}
Parameter <frequency> the frequency value.
Unit Hz (Hertz)

Query Response | <numeric>
Preset Value 1 GHz

Equivalent
Softkeys

Analysis > Time Domain > Cable Correction > Frequency
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Remote Control Commands

SENS:CORR:TRAN:TIME:LOSS

SENSe<Ch>:CORRection:TRANsform: TIME:LOSS <numeric>

SENSe<Ch>:CORRection:TRANsform:TIME:LOSS?

Sets or reads out the cable loss value for the cable correction
Description function, when the time domain transformation function is turned
ON. (command/query)

Taraet Channel <Ch>,

g <Ch>={[1]12131415]61718]9}
Parameter <numeric> the cable loss value.
Unit dB/m (decibell / meter)

Query Response | <numeric>

Preset Value 0 dB/m

Equivalent

Analysis > Time Domain > Cable Correction > Cable Loss
Softkeys
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SENS:CORR:TRAN:TIME:RVEL

SENSe<Ch>:CORRection:TRANsform:TIME :RVELocity <numeric>

SENSe<Ch>:CORRection:TRANsform:TIME:RVELocity?

Sets or reads out the cable relative wave speed velocity for the
cable correction function, when the time domain transformation

Description Lo
p function is turned ON.
(command/query)
Taraet Channel <Ch>,

g <Ch>={[1]112131415]161718]9}
Parameter <numeric> the cable velocity factor.
Query Response | <numeric>
Preset Value 1.0

Equivalent
Softkeys

Analysis > Time Domain > Cable Correction > Velocity Factor
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SENS:CORR:TRAN:TIME:STAT

SENSe<Ch>:CORRection:TRANsform: TIME:STATe <bool>

SENSe<Ch>:CORRection:TRANsform: TIME:STATe?

Turns ON/OFF the cable correction when the time domain

Description transformation function is turned ON. (command/query)
Taraet Channel <Ch>,
g <Ch>={[1112131415]1617]18]9}
Specifies state of the cable correction:
Parameter {ON|1} : ON
{OFF |0} : OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Analysis > Time Domain > Cable Correction > Cable Correction
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SENS:CORR:TYPE?

Remote Control Commands

SENSe<Ch>:CORRection:TYPE<Tr>?

Reads out the applied calibration type and the port numbers for the

Description specified trace (query only).
Trace <Tr> of channel <Ch>,

Target <Tr>={[1]12]1314|5]16]7|8}
<Ch>={[1]12131415161718]9}
{RESPO|RESPS|RESPT|SOLT1 | SOLT2 | 1PATH|NONE},
<srcport>,<rcvport>
Where:

RESPO : Response (Open)
RESPS : Response (Short)
RESPT : Response (Thru)

Query Response
SOLT1 : Full 1-port calibration
1PATH : One path 2-port calibration
NONE : Not defined
<rcvport>, the number of the receiver port from 1 to 2
<srcport>, the number of the source port =1

Equivalent

Softkeys None
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SENS:FREQ

SENSe<Ch>:FREQuency|[:CW] <frequency>

SENSe<Ch>:FREQuency|[:FIXed] <frequency>

SENSe<Ch>:FREQuency[:CW]?

SENSe<Ch>:FREQuency|[:FIXed]?

Sets or reads out he fixed frequency for the power sweep

Description (command/query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/6]718]9}
<frequency> the CW frequency value
Parameter from 3E5 to 1.3E9 (Planar - TR1300/1),
from 2E4 to 4.8E9 (TR5048),
from 2E4 to 3.0E9 (TR7530).
Unit Hz (Hertz)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>

Preset Value

6.5015E8 (Planar - TR1300/1),
2.40001E9 (TR5048),
1.50001E9 (TR7530).

Equivalent
Softkeys

Stimulus > Power > CW Freq
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Remote Control Commands

SENS:FREQ:DATA?

SENSe<Ch>:FREQuency:DATA?

Reads out the array of the measurement points frequency (query
only).
The array size is N, where N is the number of measurement points.

Description .
p For the n-th point, where n from 1 to N:

<numeric n> the frequency value at the n—-th measurement
point

Taraet Channel <Ch>,

9 <Ch>={[1]1213141516/718]9}

<numeric 1>, <numeric 2>, .<numeric N>

Query Response The data transfer format depends on the FORM: DATA command
setting.

Related FORM:DATA

Commands

Equivalent

q None
Softkeys
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Remote Control Commands

SENS:FREQ:CENT

SENSe<Ch>:FREQuency:CENTer <frequency>

SENSe<Ch>:FREQuency:CENTer?

Sets or reads out the stimulus center value of the sweep range for

Description linear or logarithmic sweep type (command/query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/6]718]9}
<frequency> the stimulus center value
Parameter from 3E5 to 1.3E9 (Planar - TR1300/1),
from 2E4 to 4.8E9 (TR5048),
from 2E4 to 3.0E9 (TR7530).
Unit Hz (Hertz)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>

Preset Value

6.5015E8 (Planar - TR1300/1),
2.40001E9 (TR5048),
1.50001E9 (TR7530)

Equivalent
Softkeys

Stimulus > Center

220




Remote Control Commands

SENS:FREQ:SPAN

SENSe<Ch>:FREQuency:SPAN <frequency>

SENSe<Ch>:FREQuency: SPAN?

Sets or reads out the stimulus span value of the sweep range for

Description linear or logarithmic sweep type (command/query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/6]718]9}
<frequency> the stimulus span value
Parameter from O to 1.2997E9 (Planar - TR1300/1),
from O to 4.79998E9 (TR5048),
from O to 2.99998E9 (TR7530).
Unit Hz (Hertz)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>

Preset Value

1.2997E9 (Planar - TR1300/1),
4.79998E9 (TR5048),
2.99998E9 (TR7530).

Equivalent
Softkeys

Stimulus > Span
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Remote Control Commands

SENS:FREQ:STAR

SENSe<Ch>:FREQuency:STARt <frequency>

SENSe<Ch>:FREQuency:STARt?

Sets or reads out the stimulus start value of the sweep range for

Description linear or logarithmic sweep type (command/query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/6]718]9}
<frequency> the stimulus start value
Parameter from 3E5 to 1.3E9 (Planar - TR1300/1),
from 2E4 to 4.8E9 (TR5048),
from 2E4 to 3.0E9 (TR7530).
Unit Hz (Hertz)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>

Preset Value

3E5 (Planar - TR1300/1),
2E4 (TR5048),
2E4 (TR7530).

Equivalent
Softkeys

Stimulus > Start
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Remote Control Commands

SENS:FREQ: STOP

SENSe<Ch>:FREQuency:STOP <frequency>

SENSe<Ch>:FREQuency:STOP?

Sets or reads out the stimulus stop value of the sweep range for

Description linear or logarithmic sweep type (command/query).
Taraet Channel <Ch>,
g <Ch>={[1]121314151617181]9}
<frequency> the stimulus stop value
Parameter form 3E5 to 1.3E9 (Planar - TR1300/1),
from 2E4 to 4.8E9 (TR5048),
from 2E4 to 3.0E9 (TR7530).
Unit Hz (Hertz)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>

Preset Value

1.3E9 (Planar - TR1300/1),
4 .8E9 (TR5048),
3.0E9 (TR7530).

Equivalent
Softkeys

Stimulus > Stop
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SENS:OFFS

SENSe<Ch>:0FFSet[:STATe] {ON|OFF|1]|0}

SENSe<Ch>:0FFSet [:STATe]?

Sets or reads out the ON/OFF state of the frequency offset feature

Description (command/query).
Taraet Channel <Ch>,
9 <Ch>={[111213141516171819}
{ON|1}  frequency offset ON
Parameter
{OFF |0} frequency offset OFF
Query Response | {01}
Preset Value 0

Equivalent .
Softkeys Stimulus > Freq. Offset > Freq. Offset
SENS:OFFS:ADJ

SENSe<Ch>:0FFSet:ADJust[:STATe] {ON|OFF|1]0}

SENSe<Ch>:0FFSet :ADJust [:STATe]?

Sets or reads out the ON/OFF state of the frequency offset adjust

Description feature (command/query).
Taraet Channel <Ch>,
9 <Ch>={[1]12131415/6]718]9}
{ON|1} frequency offset adjust ON
Parameter
{OFF|0}  frequency offset adjust OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Stimulus > Freq. Offset > Offset Adjust > Offset Adjust
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Remote Control Commands

SENS:OFFS:ADJ:CONT

SENSe<Ch>:0FFSet:ADJust:CONTinuous|[:STATe] {ON|OFF|1]|0}

SENSe<Ch>:0FFSet:ADJust:CONTinuous[:STATe]?

Sets or reads out the ON/OFF state of the continuous frequency

Description offset adjust feature (command/query).
Taraet Channel <Ch>,
g <Ch>={[1]12131415161718]9}
{ON|1}  continuous frequency offset adjust ON
Parameter
{OFF|0} continuous frequency offset adjust OFF
Query Response | {01}
Preset Value 0

Equivalent
Softkeys

Stimulus > Freq. Offset > Offset Adjust > Contin. Adjust
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Remote Control Commands

SENS:OFFS:ADJ:CONT:PER

SENSe<Ch>:0FFSet :ADJust :CONTinuous:PERiod <numeric>

SENSe<Ch>:0FFSet:ADJust :CONTinuous:PERiod?

. Sets or reads out the period for continuous offset adjust feature
Description
(command/query).
Taraet Channel <Ch>,
g <Ch>={[1]12131415161718]9}
<numeric> the period for continuous offset adjust feature:
1- 3sec,
2 - 10 sec,
Parameter
3 - 30sec,
4 - 100 sec,
5 - 300 sec,
Unit n/a
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 3
Eaui
quivalent Stimulus > Freq. Offset > Offset Adjust > Adjust Period
Softkeys
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Remote Control Commands

SENS:OFFS:ADJ:EXEC

SENSe<Ch>:0FFSet:ADJust:EXECute

Executes the offset adjust when the frequency offset feature is ON

Description (no query).
Taraet Channel <Ch>,
g <Ch>={[1]1213141516171819}
Equivalent Stimulus > Freq. Offset > Offset Adjust > Adjust Inmediate
Softkeys
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Remote Control Commands

SENS:OFFS:ADJ:PORT

SENSe<Ch>:0FFSet :ADJust : PORT <numeric>

SENSe<Ch>:0FFSet :ADJust : PORT?

Sets or reads out the port number for frequency offset adjust feature

Description (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]61718]9}
Parameter <numeric> port number 1 to 2;
Unit n/a
Out of Range Sets the value of the limit, which is closer to the specified value.

Query Response | <numeric>

Preset Value 1

Equivalent

Stimulus > Freq. Offset > Offset Adjust > Select Port
Softkeys
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Remote Control Commands

SENS:OFFS:ADJ:VAL

SENSe<Ch>:0FFSet:ADJust :VALue <hertz>

SENSe<Ch>:0FFSet:ADJust:VALue?

Sets or reads out the frequency offset adjust value of the offset

Description adjust feature (command/query).
Taraet Channel <Ch>,
9 <Ch>={[1112131415/6]7/819}
<hertz> adjust value of the offset adjust feature from -5E5 to
Parameter
5ES;
Unit Hz
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Stimulus > Freq. Offset > Offset Adjust > Adjust Value
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Remote Control Commands

SENS:OFFS:PORT:DATA?

SENSe<Ch>:0FFSet : PORT<Pt>[ :FREQuency] : DATA?

Reads out the array of the frequency points of port <Pt> when the
frequency offset feature is ON and offset type is "PORT" (query only).

Description The array size is N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:
<numeric n> the frequency value at the n-th point
Port <Pt> of channel <Ch>,

Target <Ch>={[1]121314|5|6]1718]9}
<Pt>={[111]2}
<numeric 1>, <numeric 2>, ..<numeric N>

Query Response The data transfer format depends on the FORM: DATA command
setting.
FORM: DATA

Related SENS: OFFS : STAT

Commands SENS:OFFS: TYPE

Equivalent

q None
Softkeys
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Remote Control Commands

SENS:OFFS:PORT:DIV

SENSe<Ch>:0FFSet : PORT<Pt>[:FREQuency] :DIVisor <numeric>

SENSe<Ch>:0FFSet :PORT<Pt>[ :FREQuency] :DIVisor?

Sets or reads out the basic frequency range divisor of port <Pt>

Description when the frequency offset feature is ON and offset type is "PORT"
(command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1112131415]161718]9}
<Pt>={[1]|2}
Parameter <numeric> divisor from 1 to 1000;
Unit n/a
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 1

Related SENS:0FFS:STAT

Commands SENS:OFFS:TYPE

Equivalent . -
Stimulus > Freq. Offset > Port n > Divider

Softkeys
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Remote Control Commands

SENS:OFFS:PORT:MULT

SENSe<Ch>:0FFSet : PORT<Pt>[:FREQuency] :MULTiplier <numeric>

SENSe<Ch>:0FFSet : PORT<Pt>[ :FREQuency] :MULTiplier?

Sets or reads out the basic frequency range multiplier of port <Pt>

Description when the frequency offset feature is ON and offset type is "PORT"
(command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1112131415]161718]9}
<Pt>={[1]|2}
Parameter <numeric> multiplier from -1000 to 1000;
Unit n/a
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 1

Related SENS:0FFS:STAT

Commands SENS:OFFS:TYPE

Equivalent Stimulus > Freq. Offset > Port n > Multiplier
Softkeys 9- P

232




Remote Control Commands

SENS:OFFS:PORT:OFFS

SENSe<Ch>:0FFSet : PORT<Pt>[:FREQuency] :OFFSet <hertz>

SENSe<Ch>:0FFSet : PORT<Pt>[ :FREQuency] : OFFSet?

Sets or reads out the basic frequency range offset of port <Pt> when

Description the frequency offset feature is ON and offset type is "PORT"
(command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1112131415]161718]9}
<Pt>={[1]|2}
Parameter <hertz> offset from -1el12 to 1lel2;
Unit Hz
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Related SENS:0FFS:STAT
Commands SENS:OFFS:TYPE
Equivalent .
Stimulus > Freq.Offset > Port n > Offset
Softkeys
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Remote Control Commands

SENS:OFFS:PORT:STAR

SENSe<Ch>:0FFSet : PORT<Pt>[ :FREQuency] : STARt <hertz>

SENSe<Ch>:0FFSet : PORT<Pt>[:FREQuency] : STARtL?

Sets or reads out the frequency sweep start of port <Pt> when the

Description frequency offset feature is ON and offset type is "PORT"
(command/query).
Port <Pt> of channel <Ch>,

Target <Ch>={[1112131415]161718]9}
<Pt>={[1]|2}

Unit Hz

Query Response | <numeric>

Related SENS:0FFS:STAT

Commands SENS:OFFS:TYPE

Equivalent Stimulus > Freq. Offset > Port n > Start

Softkeys %
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Remote Control Commands

SENS:OFFS:PORT:STOP

SENSe<Ch>:0FFSet : PORT<Pt>[:FREQuency] : STOP <hertz>

SENSe<Ch>:0FFSet : PORT<Pt>[ :FREQuency] : STOP?

Sets or reads out the frequency sweep stop of port <Pt> when the

Description frequency offset feature is ON and offset type is "PORT"
(command/query).
Port <Pt> of channel <Ch>,

Target <Ch>={[1112131415]161718]9}
<Pt>={[1]|2}

Unit Hz

Query Response | <numeric>

Related SENS:0FFS:STAT

Commands SENS:OFFS:TYPE

Equivalent Stimulus > Freq.Offset > Port n > Sto

Softkeys % P
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Remote Control Commands

SENS:ROSC:SOUR

SENSe<Ch>:R0OSCillator:SOURce <char>

SENSe<Ch>:R0OSCillator:SOURce?

Sets or reads out the internal or external source of the reference

Description frequency of 10 MHz (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]161718]9}
<char> choose from:
Parameter INTernal : Internal source of the reference frequency
EXTernal : External source of the reference frequency
Out of Range Error occurs. The command is ignored.
Query Response | {INT|EXT}
Preset Value INT

Equivalent
Softkeys

System > Misc Setup > Ref Source
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Remote Control Commands

SENS:SEGM:DATA

SENSe<Ch>:SEGMent : DATA <numeric list>

SENSe<Ch>:SEGMent : DATA?

Sets or reads out the array of the segment sweep table
(command/query).

The array has the following format:
{<Buf>, <Flagl>, <Flag2>, <Flag3>, <Flagé4>,
<Flagb5>, <N>,

<Start 1>, <Stop 1>, <NOP 1> [,<IFBW 1>] [,<Pow

1>] [,<Del 1>] [,<Time 1>7,

<Start 2>, <Stop 2>, <NOP 2> [,<IFBW 2>] [,<Pow

2>] [,<Del 2>] [,<Time 2>7,

<StartN>, <StopN>, <NOP N> [,<IFBW N>] [,<Pow
N>] [,<Del N>] [,<TimeN>]}

<Buf> Always 5,
<Flagl> Stimulus start setting (0 - start/stop, 1 -
center/span),
<Flag2> Setting of the <IFBW> field (0O - disabled, 1 -
Description enabled),
<Flag3> Setting of the <Pow> field (O - disabled, 1 -
enabled),
<Flag4> Setting of the <Del> field (0 - disabled, 1 - enabled),
<Flag5> Setting of the <Time> field (0 - disabled, 1 -
enabled),
<N> Number of segments,
<Start n> Start value of the n-th segment,
<Stop n>  Stop value of the n—th segment,
<NOP n> Number of points of the n—th segment,
<IFBW n> |F bandwidth of the n-th segment (if enabled),
<Pow n> Power of the n—-th segment (if enabled),
<Del n> Measurement delay of the n-th segment (if enabled),
<Time n>  Reserved for future use (if enabled)
Target Chann_el <Ch>,
<Ch>={[1]112]131415]161718]9}
<numeric 1>,<numeric 2>,..<numeric 7+MxN>
Query Response Where,
N - the number of the segments,
M - depends on the values of the flags
M = 3 + <Flag2> + <Flag3> + <Flag4> + <Flagb5>
_I;-Zjl;;llgfjnt Stimulus > Segment Table
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Remote Control Commands

SENS:SWE:POIN

SENSe<Ch>:SWEep:POINts <numeric>

SENSe<Ch>:SWEep:POINts?

Sets or reads out the number of measurement points

Description (command/query).
Taraet Channel <Ch>,
g <Ch>={[1]121314151617181]9}
<numeric> the number of measurement points
Parameter from 2 to 16001 (Planar - TR1300/1),
from 2 to 100001 (TR5048),
from 2 to 100001 (TR7530).
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 201

Equivalent
Softkeys

Stimulus > Points
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Remote Control Commands

SENS:SWE:POIN:TIME

SENSe<Ch>:SWEep:POINt:TIME <time>

SENSe<Ch>:SWEep:POINt: TIME?

Sets or reads out the delay before measurement in each

Description measurement point (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]61718]9}
Parameter <time> the measurement delay value from 0 to 0.3
Resolution 5E-6
Unit s (second)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Stimulus > Meas Delay
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Remote Control Commands

SENS:SWE:TYPE

SENSe<Ch>:SWEep:TYPE <char>

SENSe<Ch>:SWEep:TYPE?

Description Sets or reads out the sweep type (command/query).
Taraet Channel <Ch>,
9 <Ch>={[1]112131415/6]718]9}
<char> specifies the sweep type:
LINear : Linear frequency sweep
LOGarithmic : Logarithmic frequency sweep
Parameter
SEGMent : Segment frequency sweep
POWer : Power sweep
VVM : Vector Voltmeter mode
Out of Range Error occurs. The command is ignored.
Query Response | {LIN|LOG|SEGM|POW}

Preset Value

LIN

Equivalent
Softkeys

Stimulus > Sweep Type
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Remote Control Commands

SENS:VVM:TYPE

SENSe<Ch>:VVM:TYPE <char>

SENSe<Ch>:VVM:TYPE?

. Sets or reads out the smeasured parameter in Vector Voltmeter
Description
mode.
Taraet Channel <Ch>,
g <Ch>={[1]12131415161718]9}
<char> choose from:
S11 : Reflection parameter
S21 : Transmission parameter
Parameter
AB : The ratio of the receivers signals A to B, an
external frequency generator is used.
B/A : The ratio of the receivers signals B to A, an
external frequency generator is used.
Out of Range Error occurs. The command is ignored..
Query Response | {S11|S21|A/B|B/A}
Preset Value S11
Equivalent .
Softkeys Stimulus > Vector Voltmeter > Measurement > {S11|S21|A/B|B/A}

241




Remote Control Commands

SENS:VVM:FORM

SENSe<Ch>:VVM:FORMat <char>

SENSe<Ch>:VVM: FORMat?

Description Sets or reads out the data format in Vector Voltmeter mode.

Channel <Ch>,

Target <Ch>={[1]121314/5/6]7/8]9}

<char> choose from:

LOGP : Log magnitude and phase
Parameter LINP : Linear magnitude and phase
SWR : Voltage standing wave ratio
IMP : Impedance value
Out of Range Error occurs. The command is ignored..

Query Response | {LOGP |LINP|SWR|IMP}

Preset Value LOGP

Equivalent

Stimulus > Vector Voltmeter > Format > {LOGP | LINP | SWR | IMP}
Softkeys
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Remote Control Commands

SENS:VVM:FREQ

SENSe<Ch>:VVM: FREQuency[:CW] <numeric>

SENSe<Ch>:VVM: FREQuency[:CW]?

Sets or reads out the operating frequency in the Vector

Description
P Voltmeter mode.

Taraet Channel <Ch>,

9 <Ch>={[1]12131415]61718]9}
Parameter <numeric> the frequency value.
Unit Hz (Hertz)
Query Response | <numeric>
Equivalent Stimulus > Vector Voltmeter > Frequenc
Softkeys q y
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Remote Control Commands

SENS:VVM:DATA?

SENSe<Ch>:VVM:DATA?

Reads out the value of the vector voltmeter measurement (query
only). If a reference value is specified, the return value is read
relatively to it.

The data include 2 elements:

Description

<numeric 1> Magnitude value, depending on the data
format or SWR value;

<numeric 2> Phase value or zero in SWR format.

Taraet Channel <Ch>,

g <Ch>={[1]12131415]6/71819}

Query Response | <numeric 1>, <numeric 2>
SENSe<Ch>:VVM: FORMat

Related .
SENSe<Ch>:VVM:REFerence:MEMorize

Commands SENSe<Ch>:VVM:REFerence:CLEar

Equivalent

q None
Softkeys

SENS:VVM:REF:CLE

SENSe<Ch>:VVM:REFerence:CLEar

Description Clears the reference value of the vector voltmeter .
Taraet Channel <Ch>,
g <Ch>={[1]12131415161718]9}
Equivalent .
Stimulus > Vector Voltmeter > Clear Reference
Softkeys
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Remote Control Commands

SENS:VVM:REF-MEM

SENSe<Ch>:VVM:REFerence:MEMorize

Description Memorizes the reference value of the vector voltmeter .
Taraet Channel <Ch>,
9 <Ch>={[1]12131415]161718]9}
Equivalent .
Stimulus > Vector Voltmeter > Save Reference
Softkeys

SENS:VVM:REF:DATA?

SENSe<Ch>:VVM:REFerence:DATA?

Reads out the reference value of the vector voltmeter measurement

(query only).
The data include 2 elements:

Description . . .
P <numeric 1> Magnitude value, depending on the data
format or SWR value;

<numeric 2> Phase value or zero in SWR format.

Taraet Channel <Ch>,

g <Ch>={[1]]21314]5/6171819}

Query Response | <numeric 1>, <numeric 2>
SENSe<Ch>:VVM: FORMat

Related .
SENSe<Ch>:VVM:REFerence:MEMorize

Commands SENSe<Ch>:VVM:REFerence:CLEar

Equivalent

q None
Softkeys
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Remote Control Commands

SENS:VVM:TABL:CLE
SENSe<Ch>:VVM:TABLe:CLEar
.. Clears all data from the vector voltmeter measurement
Description
table.
Taraet Channel <Ch>,
9 <Ch>={[11121314|5]6]1718]|9}
Related SENSe<Ch>:VVM: TABLe:MEMorize
SENSe<Ch>:VVM: TABLe: INSert
Commands SENSe<Ch>:VVM: TABLe : REMove
Equivalent Stimulus > Vector Voltmeter > Data Table > Clear Table
Softkeys
SENS:VVM:TABL:MEM

SENSe<Ch>:VVM: TABLe :MEMorize

Description Saves measurements of the vector voltmeter to the table.
Taraet Channel <Ch>,
g <Ch>={[1]12131415/61718]9}
Related SENSe<Ch>:VVM: TABLe :MEMorize
SENSe<Ch>:VVM: TABLe: INSert
Commands SENSe<Ch>:VVM: TABLe : REMove
Equivalent .
Stimulus > Vector Voltmeter > Data Table > Add Data
Softkeys
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Remote Control Commands

SENS:VVM:TABL:INS

SENSe<Ch>:VVM: TABLe :MEMorize

Inserts a row of data into the table with the current
measurement of a vector voltmeter
Description
<numeric> The row number in the table where new
data will be inserted.
Taraet Channel <Ch>,
g <Ch>={[1112131415/61718]9}
SENSe<Ch>:VVM: TABLe :MEMorize
Related
SENSe<Ch>:VVM:TABLe:INSert
Commands SENSe<Ch>:VVM: TABLe : REMove
Equi .
quivalent Stimulus > Vector Voltmeter > Data Table > Insert Data
Softkeys
SENS:VVM:TABL:REM

SENSe<Ch>:VVM: TABLe :REMove <numeric>

Removes a table row with a vector voltmeter measurement
index

Description

<numeric> The row number in the table which will be
removed.
Taraet Channel <Ch>,
g <Ch>={[1]121314]5/61718]9}

SENSe<Ch>:VVM:TABLe:CLEar

Related .
SENSe<Ch>:VVM: TABLe :MEMorize

Commands SENSe<Ch>:VVM: TABLe: INSert

Equivalent .
Stimulus > Vector Voltmeter > Data Table > Remove Data

Softkeys
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Remote Control Commands

SENS:VVM:TABL:SAVE

SENSe<Ch>:VVM:TABLe:SAVE <string>

Description Saves the table into CSV file.

Channel <Ch>,

Target <Ch>={[1]|213|415161718|9}

Parameter <string> File name (quoted string)

If the full path of the file is not specified, the \CSV subdirectory of
Notes the main directory will be searched for the file. The file has *.csv
extension by default.

Equivalent

Stimulus > Vector Voltmeter > Data Table > Save Table to CSV
Softkeys

248



Remote Control Commands

SENS:VVM:TABL:DATA?

SENSe<Ch>:VVM: TABLe : DATA

Returns data table of the vector voltmeter (query only).
The array has the following format:

{<Flagl>, <N>,
<Abs.Mag 1>, <Abs.Phase 1> [,<Rel.Mag 1>] [,<Rel.Phase 1>],

<Abs.Mag N>, <Abs.Phase N> [,<Rel.Mag N>] [,<Rel.Phase N>1},

Description Where:
<Flagl> reference value, O - is not specified, 1 - is specified,
N - rows number in the data table;
<Abs.Mag i>, <Abs.Phase i> - measurement data of a vector
voltmeter;
[,<Rel.Mag i>] [,<Rel.Phase i>] - measurement data relative to the
reference value (if specified).

Target Channel <Ch>,
<Ch>={[1]121314151617181]9}
<numeric 1>,<numeric 2>,..<numeric 2+Nx (2+Mx2)>
Where:

Query Response N - number of table rows,
M - flag value Flagl
SENSe<Ch>:VVM: TABLe:CLEar

Related SENSe<Ch>:VVM: TABLe:MEMorize

Commands SENSe<Ch>:VVM: TABLe:REMove
SENSe<Ch>:VVM:TABLe: INSert

Equivalent None

Softkeys
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Remote Control Commands

SERV:CHAN:ACT?

SERVice:CHANnel :ACTive?

Description Reads out the active channel number (query only).
Query Response | <numeric> from 1to 16

Equivalent

Softkeys None

SERV:CHAN:COUN?

SERVice:CHANnel : COUNt?

Description Reads out the maximum number of the channels (query only).

Query Response | <numeric>

Equivalent

Softkeys None

SERV:CHAN:TRAC:ACT?

SERVice:CHANnel<Ch>:TRACe:ACTive?

Description Read out the active trace number of the channel (query only).

Taraet Channel <Ch>,

g <Ch>={[1]112131415]161718]9}

Query Response | <numeric> from 1to 16

Equivalent

Softkeys None
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SERV:CHAN:TRAC:COUN?

SERVice:CHANnel : TRACe : COUNt?

Description only).

Reads out the maximum number of the traces in the channel (query

Query Response | <numeric>

Equivalent

Softkeys None

SERV:PORT:COUN?

SERVice:PORT:COUNt?

Description Reads out the number of the ports (query only).

Query Response | <numeric>

Equivalent

Softkeys None

SERV:SWE:FREQ:MAX?

SERVice:SWEep: FREQuency:MAXimum?

Description only).

Reads out the upper limit of the measurement frequency (query

Query Response | <numeric>

Unit Hz (Hertz)
Equivalent
Softkeys None
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SERV:SWE:FREQ:MIN?

SERVice:SWEep:FREQuency:MINimum?

Reads out the lower frequency of the measurement frequency

Description (query only).

Query Response | <numeric>

Unit Hz (Hertz)
Equivalent
Softkeys None

SERV:SWE:POIN?

SERVice:SWEep:POINts?

Reads out the maximum number of the measurement points (query

Description only).

Query Response | <numeric>

Equivalent

Softkeys None
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SOUR:POW

SOURce<Ch>:POWer [:LEVel] [:IMMediate] [ :AMPLitude] <power>

SOURce<Ch>:POWer [ :LEVel] [ :IMMediate] [ :AMPLitude]?

Sets or reads out the power level for the frequency sweep

Description (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]61718]9}
Parameter <power> the power level from -55 to +3
Resolution 0.05
Unit dBm (decibels above 1 milliwatt)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Stimulus > Power > Output Power
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SOUR:POW:CENT

SOURce<Ch>:POWer:CENTer <power>

SOURce<Ch>:POWer :CENTer?

Sets or reads out the center value of the power sweep range

Description (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]61718]9}
Parameter <power> the power sweep center value from -55 to +3
Resolution 0.025
Unit dBm (decibels above 1 milliwatt)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value -22.5

Equivalent
Softkeys

Stimulus > Center
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SOUR:POW:SLOP

SOURce<Ch>:POWer [ :LEVel] : SLOPe [ :DATA] <power>

SOURce<Ch>:POWer[:LEVel] : SLOPe [ : DATA]?

Sets or reads out the power slope value for the frequency sweep

Description (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]61718]9}
Parameter <power> the power slope value from -2 to +2
Resolution 0.1
Unit dB/GHz (decibel/gigahertz)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 0

Equivalent
Softkeys

Stimulus > Power > Power Slope [dB/GHz]
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SOUR:POW:SPAN

SOURce<Ch>:POWer:SPAN <power>

SOURce<Ch>:POWer:SPAN?

Sets or reads out the power span for the power sweep

Description (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]61718]9}
Parameter <power> the power sweep span value from O to 58
Resolution 0.05
Unit dBm (decibels above 1 milliwatt)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 58

Equivalent
Softkeys

Stimulus > Span
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SOUR:POW:STAR

SOURce<Ch>:POWer:STARt <power>

SOURce<Ch>:POWer:STARt?

Sets or reads out the power sweep start for the power sweep

Description (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]61718]9}
Parameter <power> the power sweep start from -55 to +3
Resolution 0.05
Unit dBm (decibels above 1 milliwatt)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value -55

Equivalent
Softkeys

Stimulus > Start
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SOUR:POW:STOP

SOURce<Ch>:POWer:STOP <power>

SOURce<Ch>:POWer:STOP?

Sets or reads out the power sweep stop for the power sweep

Description (command/query).
Target Channel <Ch>,
<Ch>={[1]112131415]61718]9}
Parameter <power> the power sweep stop from -55 to +3
Resolution 0.05
Unit dBm (decibels above 1 milliwatt)
Out of Range Sets the value of the limit, which is closer to the specified value.
Query Response | <numeric>
Preset Value 3

Equivalent
Softkeys

Stimulus > Stop
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STAT:OPER?

STATus:0OPERation[:EVENt]?

Reads out the value of the Operation Status Event Register (query

Description only).

Target Status Reporting System

Query Response | <numeric>

Equivalent
Softkeys None
STAT:OPER:COND?

STATus : OPERation:CONDition?

Reads out the value of the Operation Status Condition Register

Description (query only).

Target Status Reporting System

Query Response | <numeric>

Equivalent

Softkeys None
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STAT:OPER:ENAB

STATus :OPERation:ENABle <numeric>

STATus:OPERation:ENABle?

Sets or reads out the value of the Operation Status Enable Register

Description (command/query).
Target Status Reporting System
Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 0
Equivalent
Softkeys None

260



Remote Control Commands

STAT:OPER:NTR

STATus :O0PERation:NTRansition <numeric>

STATus :OPERation:NTRansition?

Sets or reads out the value of the Negative transition filter of the

Description Operation Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 0
Equivalent
Softkeys None
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STAT:OPER:PTR

STATus :O0PERation:PTRansition <numeric>

STATus :OPERation:PTRansition?

Sets or reads out the value of the Positive transition filter of the

Description Operation Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from 0 to 65535
Out of Range Bit-to-bit AND with numeric 65535
Query Response | <numeric>
Preset Value 65535
Equivalent
Softkeys None
STAT:PRES

STATus : PRESet

Description Resets all the status registers to the factory settings (no query).
Target Status Reporting System
Query Response | <numeric>
Equivalent
N
Softkeys one
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STAT:QUES:COND?
STATus :QUEStionable:CONDition?

. Reads out the value of the Questionable Status Condition Register

Description
(query only).

Target Status Reporting System
Query Response | <numeric>
Equivalent
Softkeys None

STAT:QUES:ENAB

STATus:QUEStionable:ENABle <numeric>

STATus:QUEStionable:ENABle?

Sets or reads out the value of the Questionable Status Enable

Description Register (command/query).

Target Status Reporting System

Parameter <numeric> from 0 to 65535

Out of Range Bit—to-bit AND with numeric 65535
Query Response | <numeric>

Preset Value 0

T e
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STAT:QUES:LIM:CHAN:COND?

STATus:QUEStionable:LIMit:CHANnel<Ch>:CONDition?

Reads out the value of the Questionable Limit Channel Status

Description Condition Register (query only).
Taraet Channel <Ch>,

g <Ch>={[1]12131415161718]9}
Query Response | <numeric>
Equivalent
Softkeys None

STAT:QUES:LIM:CHAN:ENAB

STATus:QUEStionable:LIMit :CHANnel<Ch>:ENABle <numeric>

STATus:QUEStionable:LIMit :CHANnel<Ch>:ENABle?

Sets or reads out the value of the Questionable Limit Channel Status

Description Enable Register (command/query).

Target Channel <Ch>,
<Ch>={[111213141516171819}

Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 0

T e
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STAT:QUES:LIM:CHAN:NTR

STATus :QUEStionable:LIMit:CHANnel<Ch>:NTRansition <numeric>

STATus :QUEStionable:LIMit :CHANnel<Ch>:NTRansition?

Sets or reads out the value of the Negative transition filter of the

Description Questionable Limit Channel Status Register (command/query).
Taraet Channel <Ch>,

9 <Ch>={[1]112131415/6]718]9}
Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 0
Equivalent
Softkeys None
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STAT:QUES:LIM:CHAN:PTR

STATus :QUEStionable:LIMit:CHANnel<Ch>:PTRansition <numeric>

STATus :QUEStionable:LIMit :CHANnel<Ch>:PTRansition?

Sets or reads out the value of the Positive transition filter of the

Description Questionable Limit Channel Status Register (command/query).
Taraet Channel <Ch>,

9 <Ch>={[1]112131415/6]718]9}
Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 65535
Equivalent
Softkeys None
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STAT:QUES:LIM:CHAN?

STATus:QUEStionable:LIMit:CHANnel<Ch>[:EVENt]?

Reads out the value of the Questionable Limit Channel Status Event

Description Register (query only).
Taraet Channel <Ch>,
g <Ch>={[1]112131415]161718]9}
Query Response | <numeric>
Equivalent
Softkeys None

STAT:QUES:LIM:COND?

STATus :QUEStionable:LIMit:CONDition?

.. Reads out the value of the Questionable Limit Status Condition
Description .
Register (query only).
Target Status Reporting System
Query Response | <numeric>
Equivalent
Softkeys None
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STAT:QUES:LIM:ENAB

STATus :QUEStionable:LIMit:ENABle <numeric>

STATus:QUEStionable:LIMit:ENABle?

Sets or reads out the value of the Questionable Limit Status Enable

Description Register (command/query).
Target Status Reporting System
Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 0
Equivalent
Softkeys None
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STAT:QUES:LIM:NTR

STATus :QUEStionable:LIMit:NTRansition <numeric>

STATus :QUEStionable:LIMit:NTRansition?

Sets or reads out the value of the Negative transition filter of the

Description Questionable Limit Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 0
Equivalent
Softkeys None
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STAT:QUES:LIM:PTR

STATus :QUEStionable:LIMit:PTRansition <numeric>

STATus :QUEStionable:LIMit:PTRansition?

Sets or reads out the value of the Positive transition filter of the

Description Questionable Limit Status Register (command/query).
Target Status Reporting System

Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 65535

oot von

STAT:QUES:LIM?

STATus :QUEStionable:LIMit [ :EVENt]?

. Reads out the value of the Questionable Limit Status Event Register
Description
(query only).
Target Status Reporting System
Query Response | <numeric>
Equivalent
Softkeys None
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STAT:QUES:NTR

STATus :QUEStionable:NTRansition <numeric>

STATus :QUEStionable:NTRansition?

Sets or reads out the value of the Negative transition filter of the

Description Questionable Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 0
Equivalent
Softkeys None
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STAT:QUES:PTR

STATus :QUEStionable:PTRansition <numeric>

STATus :QUEStionable:PTRansition?

Sets or reads out the value of the Positive transition filter of the

Description Questionable Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 65535
Equivalent
Softkeys None
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STAT:QUES:RLIM:CHAN:COND?

STATus:QUEStionable:RLIMit:CHANnel<Ch>:CONDition?

Reads out the value of the Questionable Ripple Limit Channel

Description Status Condition Register (query only).
Taraet Channel <Ch>,

g <Ch>={[1]121314151617181]9}
Query Response | <numeric>
Equivalent
Softkeys None

STAT:QUES:RLIM:CHAN:ENAB

STATus :QUEStionable:RLIMit:CHANnel<Ch>:ENABle <numeric>

STATus:QUEStionable:RLIMit:CHANnel<Ch>:ENARle?

Sets or reads out the value of the Questionable Ripple Limit

Description Channel Status Enable Register (command/query).

Target Channel <Ch>,
<Ch>={[111213141516171819}

Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 0

T e
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STAT:QUES:RLIM:CHAN:NTR

STATus :QUEStionable:RLIMit:CHANnel<Ch>:NTRansition <numeric>

STATus :QUEStionable:RLIMit:CHANnel<Ch>:NTRansition?

Sets or reads out the value of the Negative transition filter of the

Description Questionable Ripple Limit Channel Status Register
(command/query).
Target Channel <Ch>,

<Ch>={[1]11213141516]718]9}

Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 0
Equivalent
Softkeys None
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STAT:QUES:RLIM:CHAN:PTR

STATus :QUEStionable:RLIMit:CHANnel<Ch>:PTRansition <numeric>

STATus :QUEStionable:RLIMit:CHANnel<Ch>:PTRansition?

Sets or reads out the value of the Positive transition filter of the

Description Questionable Ripple Limit Channel Status Register
(command/query).

Target Channel <Ch>,
<Ch>={[111213141516171819}

Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 65535

e

STAT:QUES:RLIM:CHAN?

STATus :QUEStionable:RLIMit :CHANnel<Ch>[:EVENt]?

Description Reads out the value of the Questionable Ripple Limit Channel
P Status Event Register (query only).
Taraet Channel <Ch>,
9 <Ch>={[1]12131415/6]718]9}
Query Response | <numeric>
Equivalent
Softkeys None
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STAT:QUES:RLIM:COND?

STATus:QUEStionable:RLIMit:CONDition?

Reads out the value of the Questionable Ripple Limit Status

Description Condition Register (query only).
Target Status Reporting System

Query Response | <numeric>

Equivalent

Softkeys None

STAT:QUES:RLIM:ENAB

STATus:QUEStionable:RLIMit:ENABle <numeric>

STATus:QUEStionable:RLIMit:ENARle?

Sets or reads out the value of the Questionable Ripple Limit Status

Description Enable Register (command/query).
Target Status Reporting System

Parameter <numeric> from 0 to 65535

Out of Range Bit—to-bit AND with numeric 65535
Query Response | <numeric>

Preset Value 0

T e
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STAT:QUES:RLIM:NTR

STATus :QUEStionable:RLIMit:NTRansition <numeric>

STATus :QUEStionable:RLIMit:NTRansition?

Sets or reads out the value of the Negative transition filter of the

Description Questionable Ripple Limit Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 0
Equivalent
Softkeys None
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STAT:QUES:RLIM:PTR

STATus :QUEStionable:RLIMit:PTRansition <numeric>

STATus :QUEStionable:RLIMit:PTRansition?

Sets or reads out the value of the Positive transition filter of the

Description Questionable Ripple Limit Status Register (command/query).
Target Status Reporting System

Parameter <numeric> from 0 to 65535

Out of Range Bit-to-bit AND with numeric 65535

Query Response | <numeric>

Preset Value 65535

oot on

STAT:QUES:RLIM?

STATus :QUEStionable:RLIMit [ :EVENt]?

Reads out the value of the Questionable Ripple Limit Status Event

Description Register (query only).
Target Status Reporting System
Query Response | <numeric>

Equivalent

Softkeys None
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STAT:QUES?

STATus:QUEStionable[:EVENt]?

Reads out the value of the Questionable Status Event Register

Description (query only).

Target Status Reporting System
Query Response | <numeric>

Equivalent

Softkeys None

SYST:COMM:ECAL:TEMP:SENS?

SYSTem:COMMunicate:ECAL:TEMPerature:SENSor?

Reads out the temperature of the AutoCal module connected to

Description the Analyzer. (query only)
Target AutoCal module

Unit °C

Query Response | <numeric>

Equivalent

Softkeys None

279




Remote Control Commands

SYST:CORR

SYSTem:CORRection[:STATe] {ON|OFF|1|0}

SYSTem:CORRection|[:STATe]?

Sets or reads out the ON/OFF state of the system error correction

Description (command/query).

{ON|1}  System error correction ON
Parameter

{OFF |0} System error correction OFF
Query Response | {01}
Preset Value 1
Equivalent System > Misc Setup > System Correction
Softkeys 4 p>>Y

SYST:DATE

SYSTem:DATE <numeric 1>,<numeric 2>,<numeric 3>

SYSTem:DATE?

Description Sets or reads out the current date (command/query).
<numeric 1> year from 1900 to 2100;
Parameter <numeric 2> monthfrom1to 12;
<numeric 3> day from 1 to 31.
Query Response | <numeric 1>, <numeric 2>, <numeric 3>
Equivalent
Sthkeys None
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SYST:ERR?
SYSTem:ERRor [ : NEXT] ?
Reads out the error message of the error occurred when executing
the SCPI commands, from the FIFO (First In First Out) error queue
Description stored in the instrument. The read out error is deleted from the error
queue. The *CLS command clears the error queue. The maximum
size of the queue is 100 messages (query only).
<numeric>, <string>
Where:
<numeric> error code
Query Response
<string> error message
If there is no error in the queue, "0, No error” is read out.
Equivalent
9 None
Softkeys
SYST:LOC

SYSTem:LOCal

Sets the instrument to the local operation mode, when all the keys

Description on the front panel, mouse and the touch screen are active (no
query).
Related SYST:REM
Commands SYST:RWL
Equivalent
9 None
Softkeys
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SYST:PRES

SYSTem: PRESet

Description Resets the instrument to the factory settings (no query).

The difference from the*RST: command is that the trigger is set to
Notes . .

the Continuous trigger mode.
Related *RST
Commands
Equivalent

> >

Softkeys System > Preset > Apply

SYST: READyY?

SYSTem:READy [ : STATe] ?

Reads out the ready state of the Analyzer. The state is True when
analyzer hardware is connected, powered and the boot process is

Description completed (about 10 sec).
(query only)

Query Response | {01}

Equivalent

Softkeys None
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SYST:REM
SYSTem:REMote
Sets the instrument to the remote operation mode, when all the
Description keys on the front panel, mouse and the touch screen are not active,
p except for one key labeled Return to Local. Pushing this button will
reset the instrument to the local operation mode (no query).
Related SYST:LOC
Commands SYST :RWL
Equivalent
Softkeys None
SYST:RWL

SYSTem:RWLock

Sets the instrument to the remote operation mode, when all the
keys on the front panel, mouse and the touch screen are not

Description . .
active. Only SYST:LOC or SYST : REM command can release this
remote operation mode (no query).

Related SYST:LOC

Commands SYST:REM

Equivalent

9 None

Softkeys
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SYST:TEMP:SENS?

SYSTem: TEMPerature:SENSor? <numeric>

Reads out the specified sensor temperature inside the Analyzer.

Description (query only)

Target Analyzer

Parameter <numeric> :Sensor number
Unit °C

Query Response | <numeric>

T o
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SYST:TIME

SYSTem:TIME <numeric 1>,<numeric 2>,<numeric 3>

SYSTem:TIME?

Description Sets or reads out the current time (command/query).

<numeric 1> hours from 0 to 23;
Parameter <numeric 2> minutes from Oto 59;

<numeric 3> seconds from O to 59.

Query Response | <numeric 1>, <numeric 2>, <numeric 3>

Equivalent
Softkeys None
SYST:TERM
SYSTem:TERMinate
Terminates the analyzer software.
Description
(no query)
Equivalent .
> >
Softkeys System > Exit > Ok
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TRIG
TRIGger [ :SEQuence] [:IMMediate]
Generates a trigger, independently of the trigger source setting
(except for the External). If the trigger source is set to External, an
error occurs and the command is ignored.
. If the instrument is not in the waiting for a trigger state (sweep is in
Description
progress or all the channels are set to Hold), an error occurs and the
command is ignored.
The command is completed before the end of the sweep.
(no query)
TRIG:SOUR
Related INIT:CONT
Commands INIT:IMM
Equivalent
9 None
Softkeys
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TRIG:SING

TRIGger [ :SEQuence] : SINGle

Generates a trigger, independently of the trigger source setting
(except for the External). If the trigger source is set to External, an
error occurs and the command is ignored.

If the instrument is not in the waiting for a trigger state (sweep is in
Description progress or all the channels are set to Hold), an error occurs and the
command is ignored.

The command is not completed before the end of the sweep
(waiting for the completion of the sweep of all the channels).

(no query)
TRIG:SOUR
Related INIT: CONT
Commands INIT: IMM
Equivalent
q None
Softkeys
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TRIG:SOUR

TRIGger [ :SEQuence] : SOURce <char>

TRIGger [ :SEQuence] : SOURce?

Description Sets or reads out the sweep trigger source (command/query).
<char> choose from:
INTernal > Internal
Parameter EXTernal : External
MANual : Manual
BUS :Bus
Out of Range Error occurs. The command is ignored.
Query Response | { INT |EXT |MAN|BUS}
Preset Value INT
TRIG
Commands | "5SS
gz;tg:;:‘nt Stimulus > Trigger > Trigger Source > { Internal | External | Bus }
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TRIG:STAT?

TRIGger [ :SEQuence] : STATus?

Reads out the the current state of the analyzer.

Description (query only)

HOLD scanning is stopped
Parameter MEASure is scanning

WAIT is scanning
Equivalent
Softkeys None
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TRIG:WAIT

TRIGger [ :SEQuence] :WAIT <char>

Delays the execution by the analyzer of the next command till the
specified state of the analyzer has been reached (see options
below).

A query that follows the TRIG:WAIT command blocks the
execution of the user program till the specified state of the analyzer
has been reached.

Description The command can be used to wait for the end of the sweep
initianed by the commands TRIG, *TRG or initiated by the
external trigger signal. If the continuous initiation mode is turned ON
by the command INIT:CONT ON, then the parameter of the
command must be WAIT, otherwise HOLD.

(no query)
<char> choose from:
HOLD : Waits for the Hold state

Parameter
MEASure : Waits for the Measure state
WAIT : Waits for the Trigger Waiting state

Related TRIG, *TRG

Commands TRIG:SOUR EXT

Equivalent

Softkeys None
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VVM:RES

VVM[:DISPlay]:

VVM[:DISPlay]:

RESolution <numeric>

RESolution?

Sets or reads out number of indication symbols in the vector

Description voltmeter mode

Parameter Number of significant symbols from 3 to 12
Query Response | <numeric>

Preset value 5

Equivalent . . N
> >
Softkeys Stimulus > Vector Voltmeter > Properties > Response Digits
VVM:FONT

VVM[:DISPlay]

VVM[:DISPlay]

:FONT[:SIZE] <numeric>

:FONT[:SIZE]?

Sets or reads out the font size for indication in the vector

Description voltmeter mode
Parameter Font size from 3 to 12
Query Response | <numeric>

Preset value 36

Equivalent
Softkeys

Stimulus > Vector Voltmeter > Properties > Font Size
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5 Programming Tips

This section gives recommendations for programming in certain specific
situations.

5.1 Program Sweep Initiation and Waiting

The program sweep initiation and waiting for its completion the most simple
method can be implemented by using commands TRIG:SING and *OpC?. The
command TRIG:SING gerates a trigger signal and starts sweeping under the
following conditions:

e The program trigger source is selected by command TRIG: SOUR BUS;

e The analyzer should be in the trigger waiting state, otherwise (the analyzer is
sweeping or analyzer is in the Hold state) an error occurs and the command
is ignored.

The transition of the analyzer to the trigger waiting state depends on the state of
the continuous initiation mode, which is set by command INIT:CONT. Provided
that the continuous initiation mode is ON, the analyzer automatically transits to
the trigger waiting state when the program trigger source have been selected,
and then each time at the end of a sweep. Provided that the continuous initiation
mode is OFF, the analyzer transits to the trigger waiting state for single time
upon receiving the command INIT.

The command TRIG:SING remains pending until the end of sweep. This allows
use the *opc? query for the waiting the end of sweep.

Example 1. Start sweeping in all channels and waits for its completion. The
channels sweep one by one in turn. The continuous initiation mode is enabled by
default.

TRIG:SOUR BUS Selects the program trigger source and puts
the analyzer to the trigger waiting state

<loop>:

TRIG:SING Starts sweep

*OPC? Waits for the end of the sweep

After the sweep completion the analyser returns to the trigger waiting state, and
then the next sweep initiation command can be sended.
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Example 2. Start sweeping in one channel and waits for its completion, then
start sweeping in another channel and waits for its completion. The channel
number must be set to 2.

TRIG:SOUR BUS Selects the program trigger source
INIT1:CONT OFF Puts channel 1 to the hold state
INIT2:CONT OFF Puts channel 2 to the hold state

<loop>:
INIT1 Puts channel 1 to the trigger waiting state
TRIG:SING Starts sweep in channel 1
*OPC?

Waits for the end of the sweep

INIT? Puts channel 2 to the trigger waiting state
TRIG:SING Starts sweep in channel 2
*OPC? Waits for the end of the sweep

After completion of the sweep on one channel the analyser returns to the hold
state, then the sweep initiation for another channel is available.

5.2 External Trigger

If trigger source is set to the External by the command TRIG:SOUR EXT, the
sweep starts at signal arrival on the external trigger input.

At the moment of a trigger signal arrival the Analyzer must be in the trigger
waiting state, otherwise the signal is ignored but no error is detected.

As a rule the hardware trigger output is used to determine the end of the sweep.
If there is a need to determine programmatically the end of the sweep, the
TRIG:WAIT command can be used. Using program way to determine the end of
the sweep requires the continuous initiation mode turned OFF.

Example 3. Starts sweep at the signal on the external trigger input.
Programmatically waits for its completion. The continuous initiation mode must
be turned OFF.

TRIG:SOUR EXT Selects the external trigger source

LINIEIESCIONIE. Q131 Puts channel 1 to the hold state

<loop>:
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INIT Puts channel 1 to the trigger waiting state.
The sweep starts at external trigger signal
TRIG:WAIT HOLD | Waits for the end of the sweep

*OPC? Any query is required

After completion of the sweep the analyser returns to the hold state, then the
next sweep initiation is available.

5.3 Waiting for Calibration Commands

Depending on the sweep settings the calibration commands may have long
execution time, as they start sweep and wait it completion. These commands
are:

SENS : CORR:COLL : XXXX

SENS :CORR:OFFS : COLL : XXXX
SENS :CORR:REC:COLL: XXXX

SENS :CORR:COLL:ECAL: XXXX
SENS:CORR:COLL:ECAL:ORI:EXEC

The user program can determine the end of these command using any query,
the »opc» for example.

5.4 VISA Timeout Considerations

When using the query *opc? for waiting an operation the VISA timeout value
must be set to the value no less than the expected sweep time. For example in
C/C++:

viSetAttribute (instr, VI ATTR TMO VALUE, 5000);

5.5 Receiving Data Arrays in Text Form

By default the data from the analyzer is transmitted in a text form. The VISA
library has built-in facilities for receiving an array of data from the analyzer. The
example assumes that the size of the array is sufficient to receive a number of
elements equal to twice the number of points.

An example of receiving a data array in C/C++:

double DataArray[1000];

ViUInt32 retCount;
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5.6 Receiving Data Arrays in Binary Form

The transfer of data from the analyzer in binary form reduces the amount of
data transferred and the transmission time. The transfer of binary data is
supported only by the HiSLIP protocol. To enable binary data transfer, use the
FORM: DATA command. The list of commands that support the transfer of binary
data is given in the description of the FORM: DATA command.

Binary data is transmitted as a block having a header followed by data. Block
format:

# ’8 <Data Size> |<Binary Data>

Where:
# - the character '#';
8 - the character '8’;

<Data Size> - 8 bytes, the symbolic representation of the number of bytes of
binary data.

For example:
#800003216<Binary Data>
The VISA library has built-in tools for receiving binary data from the analyzer.

The example assumes that the size of the array is sufficient to receive a number
of elements equal to twice the number of points.

Example of receiving binary data array in C/C ++:

double DataArray[1000];
ViUInt32 retCount;

viPrintf (instr, "FORM:DATA REAL\n") ;
retCount = sizeof (DataArray) / sizeof (double);
viQueryf (instr, "CALC:DATA:FDAT?\n", "%#Zb", &retCount, DataArray);

// retCount now contains the actual number of elements read
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114 "Header suffix out of range"

200 "Execution error"

211 "Trigger ignored"

213 "Init ignored"

220 "Parameter Error"

222 "Data out of range"

224 "Illegal parameter value"

201 "Invalid channel index"

202 "Invalid trace index"

203 "Invalid marker index"

204 "Marker is not active"

205 "Invalid save type specifier"

206 "Invalid sweep type specifier"”
207 "Invalid trigger source specifier"
208 "Invalid measurement parameter specifier"
209 "Invalid format specifier"

210 "Invalid data math specifier"

214 "Invalid limit data"

215 "Invalid segment data"

216 "Invalid standard type specifier"
217 "Invalid conversion specifier"
218 "Invalid gating shape specifier"
219 "Invalid gating type specifier"
300 "Device-specific error"

302 "Status reporting system error"
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Example 1. Program Written in C

The following program shows the control over the instrument using the C language
with the VISA library.

The instrument address is assigned in VISA Resource Name format in the command
line at the start of the program. For more detail on VISA Resource Name see the VISA
library documentation.

Program description:

1. Sets up the communication with the instrument.

Reads out and displays the instrument information string.
Sets some parameters of the instrument.

Triggers the measurement and waits for the sweep completion.

ok N

Reads out the measurement data and the frequency values at the measurement
points.

6. Displays the measurement data

// Examplel.cpp

//

// VISA Header: visa.h (must be included)

// VISA Library: visa32.lib (must be linked with)
#include "stdafx.h"

#include "visa.h"

int main (int argc, char* argvl[])

{

ViStatus status; // Error checking

ViSession defaultRM, instr; // Communication channels

ViUInt32 retCount; // Return count from string I/O

ViByte buffer[255]; // Buffer for string I/O

int temp;

int NOP = 21; // Number of measurement
points

const int maxCnt = 100; // Maximum reading count

double Data[maxCnt*2]; // Measurement data array

double Freg[maxCnt]; // Frequency array

if (argc < 2)

{
printf ("\nUsage: Exampled4 <VISA address>\n\n");
printf ("VISA address examples:\n");
printf (" TCPIP::nnn.nnn.nnn.nnn: : INSTR\n") ;
printf (" TCPIP: :devicename: : INSTR\n") ;
return -1;

}

status = viOpenDefaultRM (&defaultRM) ;
if (status < VI _SUCCESS)

{
printf ("Can't initialize VISA\n");
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return -1;

status = viOpen (defaultRM, argv[l], VI NULL, VI NULL,
if (status < VI _SUCCESS)
{
printf ("Can't open VISA address: %$s\n", argv[l]);
return -1;
}
//
// Set the timeout for message-based communication
//
viSetAttribute (instr, VI ATTR TMO VALUE, 5000);
//
// Read ID string from Analyzer
//
viPrintf (instr, "*IDN?\n");
viRead (instr, buffer, sizeof (buffer), &retCount):;
printf ("*IDN? Returned %d bytes: %.*s\n\n", retCount,
buffer) ;
//
// Set up the Analyzer
//
viPrintf (instr, "SYST:PRES\n"):;
viPrintf (instr, "SENS:SWE:POIN %d\n", NOP) ;
viPrintf (instr, "CALC:PAR1:DEF S21\n");
viPrintf (instr, "CALC:PAR1:SEL\n");
viPrintf (instr, "CALC:FORM MLOG\n") ;
viPrintf (instr, "SENS:BAND 10\n");
//
// Trigger measurement and wait for completion
//
viPrintf (instr, ":TRIG:SOUR BUS\n") ;
viPrintf (instr, ":TRIG:SING\n"):;
viQueryf (instr, "*OPC?\n", "%d", s&temp);
//
// Read out measurement data
//

retCount = maxCnt * 2;

&instr) ;

retCount,

viQueryf (instr, "CALC:DATA:FDAT?\n", "%,#1f", &retCount, Data);

retCount = maxCnt;

viQueryf (instr, "SENS:FREQ:DATA?\n", "%,#1f", &retCount, Freq);

//

// Display measurement data
//

printf ("%$20s %

for (int i = 0; 1 < NOP; i++)
{

20s %20s\n", "Frequency", "Datal", "Data2");

printf ("$20f %$20f %$20f\n", Freql[i], Data[i*2], Data[i*2+1]);

}

status = viClose (instr) ;
status = viClose (defaultRM) ;
return 0;
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Example 2. Program Written in LabView

The following program shows the control over the instrument using the LabView
language with the VISA library.

Below see the block diagram of the program and front panel of the program with the
program execution result.

The front panel contains the entry field for the instrument name “VISA Resource
Name”. For more detail on VISA Resource Name see the VISA library documentation.

The user must enter the instrument address, select the trace format in the “Format”
field, and click the “Run” button. As the result of the program, the instrument
information string will be displayed and the measurement trace will be plotted.

Program description:

Sets up the communication with the instrument.

Reads out and displays the instrument information string.

Sets some parameters of the instrument.

Generates the trigger and waits for the sweep completion.

Sets the trace format to the format entered by the user in the “Format” field.

Reads out the measurement data.

N o v kA W

Displays the measurement data.
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